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Legal disclaimer

Alibaba Cloud reminds you to carefully read and fully understand the terms and conditions of this
legal disclaimer before you read or use this document. If you have read or used this document, it

shall be deemed as your total acceptance of this legal disclaimer.

1. You shall download and obtain this document from the Alibaba Cloud website or other Alibaba
Cloud-authorized channels, and use this document for your own legal business activities only.
The content of this document is considered confidential information of Alibaba Cloud. You shall
strictly abide by the confidentiality obligations. No part of this document shall be disclosed or
provided to any third party for use without the prior written consent of Alibaba Cloud.

2. No part of this document shall be excerpted, translated, reproduced, transmitted, or disseminat
ed by any organization, company, or individual in any form or by any means without the prior
written consent of Alibaba Cloud.

3. The content of this document may be changed due to product version upgrades, adjustment
s, or other reasons. Alibaba Cloud reserves the right to modify the content of this document
without notice and the updated versions of this document will be occasionally released through
Alibaba Cloud-authorized channels. You shall pay attention to the version changes of this
document as they occur and download and obtain the most up-to-date version of this document
from Alibaba Cloud-authorized channels.

4. This document serves only as a reference guide for your use of Alibaba Cloud products and
services. Alibaba Cloud provides the document in the context that Alibaba Cloud products and
services are provided on an "as is", "with all faults" and "as available" basis. Alibaba Cloud
makes every effort to provide relevant operational guidance based on existing technologies
. However, Alibaba Cloud hereby makes a clear statement that it in no way guarantees the
accuracy, integrity, applicability, and reliability of the content of this document, either explicitly
or implicitly. Alibaba Cloud shall not bear any liability for any errors or financial losses incurred
by any organizations, companies, or individuals arising from their download, use, or trust in
this document. Alibaba Cloud shall not, under any circumstances, bear responsibility for any
indirect, consequential, exemplary, incidental, special, or punitive damages, including lost
profits arising from the use or trust in this document, even if Alibaba Cloud has been notified of
the possibility of such a loss.

5. By law, all the content of the Alibaba Cloud website, including but not limited to works, products
, images, archives, information, materials, website architecture, website graphic layout, and
webpage design, are intellectual property of Alibaba Cloud and/or its affiliates. This intellectu

al property includes, but is not limited to, trademark rights, patent rights, copyrights, and trade



secrets. No part of the Alibaba Cloud website, product programs, or content shall be used,
modified, reproduced, publicly transmitted, changed, disseminated, distributed, or published
without the prior written consent of Alibaba Cloud and/or its affiliates. The names owned by
Alibaba Cloud shall not be used, published, or reproduced for marketing, advertising, promotion
, or other purposes without the prior written consent of Alibaba Cloud. The names owned by
Alibaba Cloud include, but are not limited to, "Alibaba Cloud", "Aliyun", "HiChina", and other
brands of Alibaba Cloud and/or its affiliates, which appear separately or in combination, as well
as the auxiliary signs and patterns of the preceding brands, or anything similar to the company
names, trade names, trademarks, product or service names, domain names, patterns, logos

, marks, signs, or special descriptions that third parties identify as Alibaba Cloud and/or its
affiliates).

6. Please contact Alibaba Cloud directly if you discover any errors in this document.
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Generic conventions

Table -1: Style conventions

Style Description Example
This warning information indicates a
situation that will cause major system Danger:
changes, faults, physical injuries, and Resetting will result in the loss of user
other adverse results. configuration data.
This warning information indicates a
''''' situation that may cause major system | &% Warning:
changes, faults, physical injuries, and | Restarting will cause business
other adverse results. interruption. About 10 minutes are
required to restore business.
This indicates warning information,
supplementary instructions, and other Note:
content that the user must understand. | Take the necessary precautions to
save exported data containing sensitive
information.
This indicates supplemental instructio
ns, best practices, tips, and other Note:
content that is good to know for the You can use Ctrl + A to select all files.
user.
> Multi-level menu cascade. Settings > Network > Set network type
Bold It is used for buttons, menus, page Click OK.
names, and other Ul elements.
Couri er It is used for commands. Runthecd /d C./w ndows command
f ont to enter the Windows system folder.
Italics |[Itisused for parameters and variables. |bae 1 og list --instanceid
I nstance_I D
[] or [a]b] It indicates that it is a optional value, i pconfig[-all]|-t]
and only one item can be selected.
{} or{alb} |Itindicates that it is a required value, swich{stand | slave}
and only one item can be selected.




Contents

Legal disClaimer..........coiiiieiiiiiiciiirrs s s e s I
Generic CONVENLIONS........cceeiiiiiirrcc e I
O 1= o 1
2 MaxCompute Studio.......cceueiiiiimmimeciiirrrrr s e 4
2.1 WhHat IS SHUAIO. . ..eeeeiieiiiiiie et e e e et e e e e s e annreeeeeeaans 4

2.2 Project space connection Management.... ..ot 9

2.3 Tools Installation and version hiStOry.............oooiiiiii e 14

2.3.1 Install Intellid IDEA. ... ... o et 14

2.3.2 Installation ProCeAUIe...........cooii it e e 18

2.3.3 View and upgrade the VErSiON..........c..ciiiiiiiiiiia e 27

2.4 Manage data and rESOUICES........cceiiiiiieciiiiieeete e e e e e e e e e e e e e e e e e e e e e e e e s eeennnnnnes 28

2.4.1 View tables and UDF..........oo et 28

2.4.2 Import and eXport data...........ceeviiieeiiiiiiicc e 32

2.4.3 Visualization of operating the tables............cccccoii e, 39

2.5 Develop SQL PrOCEAUIE. .. .. ..ueiie ettt e et e e et e e e e e eteee e e e e s anereeeaaeaanneeeeaeeanns 43

2.5.1 Create MaxCompute Script module...........cccoooeeiiiiiiiiiiiccceeeee e, 43

S T T (= T O | SRRSO 48

2.5.3 Submit SQIL SCIIPES. ..ieeiieie et 48

2.6 DEVEIOPING JAVA.....ciiiiiiiiieieiiii ettt e e e e e e e e e s e st e e e e e e eaeaeeeeeeea e ararareeaaaaens 50

2.6.1 Create MaxCompute Java Module...........cccoiiiiiiiiiiiiiiie e 50

2.6.2 Develop and debug UDF...........oooiiiiiiiiii et 51

2.6.3 Develop MapREAUCE.........ccciiiieeeeeeeee et e e e e 58

2.6.4 Unstructured development...... ..o 61

2.6.5 Package. Upload and Register.........cooouiiiiiiiiii e 63

2.6.6 DEVEIOP Graph.. .. ceeeiie ettt e e e 66

2.7 CoNfiIQUIE OPLIONS. ... ..ttt e e e et e e e e e et e e e e e eneeeeeeeeaneee 68

2.7.1 Configure MaxCompute STUdIO............uuuiiiiiiiiieeeiiiii e 69

B I 9 1o 31V 0 1 [0 Y= T =3 73



1 Client

This article describes how to use the basic functions of the MaxCompute using client command

line tool. Before using the MaxCompute client, you must install and configure the client .

Note:

* Do not perform the analysis operation based on the output format of the client. The output
format of the client is not ensured for forward compatibility. Clients of different versions are

different in their command formats and behaviors.
* For more information about basic commands of the client, see Basic commands.
* Download MaxCompute console

* The client supports JDK 1.9 from the 0.28.0 version, and the previous version can only use

JDK 1.8.

* The client supports MaxCompute 2.0 from the 0.27.0 version New data type.

After the client is installed and configured, you can use a command line to perform the following

operations.
Get Help
To view the help information of the console, the command format is as follows:
odps @>./ bi n/ odpscnd- h;
You can also input h; or hel p; (case-insensitive) in an interactive mode.

The console also provides the hel p [ keyword] ; command to get the command prompts
related to the keyword. For example, input hel p t abl e; to get command prompts related to the

table operation as follows:

odps @ odps> hel p table;
Usage: alter table nmerge smallfiles
Usage: show tables [in]

alist of tables | Is [-p,-project]
Usage: describe deserves nmention | [ [partition ()]
Usage: read [.] [partition ()] [Iine_nuni

ec
]

Start parameters

When start the console, you can specify a series of parameters as follows:

Usage: odpscnd [option]...


http://repo.aliyun.com/download/odpscmd/latest/odpscmd_public.zip

wher e options include:
--help (-h) for help
--project= use project
--endpoi nt = set endpoi nt
-u-p user name and password
-k will skip begining queries and start from specified position
-r set retry tines
-f <"file_path;"> execute command in file
-e <"command; [command;]..."> execute comand, include sgql command
-Cwill display job counters

Take the -f parameter as an example, the operation is as follows:

1. Prepare the local script file script.txt. Suppose that the file is located in the disk D, and the

content is shown as follows:

DROP TABLE | F EXI STS test _table_nj;
CREATE TABLE test _table_nm (id string, name string);
DROP TABLE test_table_nj;

2. Run the following command:
odpscrd\ bi n>odpscnd -f D:/script.txt;
Interactive mode

Run the console to directly enter the interactive mode:

[adm n: ~] $odpscnd

Al'i yun ODPS Command Li ne Tool

Version 1.0

@Copyright 2012 Ali baba C oud Conputing Co., Ltd. Al rights reserved.
odps@ odps> | NSERT OVERWRI TE TABLE DUAL SELECT * FROM DUAL;
Enter the command at the cursor position (use a semicolon as a statement terminator), and press

Enter to run.
Continuous running

»  When using -e or -f option to run a command, if there are multiple statements, and you want to
start running from a middle statement, you can specify the parameter -k, indicating to ignore
the previous statements and to start running from the specified position. When the parameter
<= 0 is specified, the execution starts from the first statement.

+ Each statement separated by a semicolon is considered as a valid statement. The statements

which run successfully or fail to run are printed out at runtime.

For example,



suppose there are three SQL statements in the file /tmp/dual.sql:

drop tabl e dual;
create table dual (dummy string);
insert overwite table dual select count(*) from dual;

To ignore the first two statements, and start running from the third statement, the command format

is as follows:
odpscnd -k 3 -f dual. sql
Get current logon user
To get current logon user, the command format is as follows:
whoam ;

Use example:

odps @ hi veut >whoam ;

Nane: odpstest@liyun.com

End_Poi nt: http://service. odps. aliyun. conf api
Project: lijunsecuritytest

Use the preceding command to get the current logon user Alibaba Cloud account, endpoint

configuration, and project name.
Exit
To exit the console, the command format is as follows:
odps@> quit;
You can also use the following command to exit the console:

odps@ > q;



2 MaxCompute Studio

2.1 What is Studio

MaxCompute Studio is a big data integrated development environment (IDE) tool that is provided
by the Alibaba Cloud MaxCompute platform and installed on the developer’s client. It is a
development plug-in based on the popular integrated development platform IntelliJ IDEA, helping
users develop data conveniently. This article describes functional interfaces and common

application scenarios of MaxCompute Studio.
Basic user interface

MaxCompute Studio is a plug-in on the IntelliJ IDEA platform, which shares basic development
interfaces with Intellid IDEA. For more information about the IntelliJ IDEA interfaces, see the

Interface operation guide.

Based on the IntelliJ IDEA interfaces, MaxCompute Studio provides the following functional

interfaces.

+ SQL Editor: Provides features such as SQL syntax highlighting, code complementing, real-

time error prompting, local compilation, and job submission.

Compiler View: Displays locally compiled prompts and error messages, and locates the code in
the editor.
* Project Explorer: Connects to a MaxCompute project, and browses table structures, custom

functions, and resource files in the project.

Table Details View: Displays details and sample data of tables, views, and other resources.

+ Job Explorer: Browses and searches for historical jobs of MaxCompute.

— Job Details View: Displays running details of a job, including the execution plan and details
of each execution task.
— Job Output View: Displays output information of a running job.
— Job Result View: Displays the output result of the SELECT job.
+ MaxCompute Console: Integrates the MaxCompute client, on which MaxCompute client

commands can be input and executed.
Connect to MaxCompute project

Before using most features of MaxCompute Studio, you must Create a project connection. After

the project connection is created, you can view related data structures and resource information in


https://www.jetbrains.com/idea/
https://www.jetbrains.com/help/idea/2016.3/guided-tour-around-the-user-interface.html
https://www.jetbrains.com/help/idea/2016.3/guided-tour-around-the-user-interface.html

the Project Explorer. MaxCompute Studio automatically creates a local metadata backup task for

each project to increase the access frequency to MaxCompute metadata and reduce the latency.

Note:

* You must specify the target project connection to modify SQL scripts, submit jobs, view
job information, open the MaxCompute console, and implement other functions using
MaxCompute Studio. Therefore, creating a connection to the MaxCompute project is
necessary.

* For more information about MaxCompute projects, see Project.

* For more information about project management using MaxCompute Studio, see Project

space connection management.
Manage data

You can use the Project Explorer of MaxCompute Studio to quickly browse table structures,
custom functions, and resource files in the project. The tree control can be used to list data tables,
columns, partition columns, virtual views, custom functions, function signatures, and resource files

and types of all project connections. It also supports fast locating.

You can double-click a data table to open the Table Details View and view metadata, structure,
and sample data of the data table. If you do not have the permission for a project, an error

message is prompted.

MaxCompute Studio integrates MaxCompute Tunnel and supports local data upload and

download. For more information, see Import and export data.
Write SQL scripts
You can easily compile a MaxCompute SQL script on MaxCompute Studio.

1. Open MaxCompute Studio and select File > New > Project or File > New > Module....
2. Create a MaxCompute Studio project or module.

3. Select File > New > MaxCompute Script or right-click the menu and select New >

MaxCompute Script , to create a maxcompute SQL script file.

Note:
When a MaxCompute SQL script is created, MaxCompute Studio prompts you to select
an associated MaxCompute project. You can also modify the associated project using the

project selector on the right of the toolbar on the SQL editor. The editor automatically checks



metadata (such as the table structure) and reports errors of an SQL statement based on
the project associated with the SQL script. The editor also sends the SQL statement to the
associated project for execution when it submits the SQL statement for running. For more

information, see Compile an SQL script.
SQL code intelligent prompt

After you enter the code, the SQL editor provided by MaxCompute Studio intelligently prompts the
syntax errors, type matching errors, or warnings of SQL statements, and marks them on the code

in real time. as shown in the following figure.

. key value + c.value

Lrmse = L Lrmse = Lr

table meta.srcp cannot be resolved

By using the code complementing function, MaxCompute Studio prompts you the name, table,
field, function, type, and code keyword of a project based on the code context, and automatically

complements the code based on your selections. as shown in the following figure.

Compile and submit a job
+ Compile a job

Click the m icon on the toolbar of the SQL editor to locally compile an SQL script. If syntax

or semantic errors occur, the editor reports it.



Information: Parsing ...

Information: Type checking ...

Information: Latency.compiler_parse_error : 44170
Information: Build failed(2)

v El fUsers/xueming.xm/ldeaProjects/MyUDF/Script/scripts
® Error:(9, 15) table meta.table_test cannot be resolved
® Error:(12, 8) table meta.table_test cannot be resolved

+ Submit a job

Click the - icon on the toolbar of the SQL editor to submit an SQL script to the queue of

the project specified by MaxCompute.
View history jobs

Open Job Explorer to view recently executed jobs in the specified project.

@ Note:

List only displays jobs submitted by the user ID of the current connection.



MaxCompute Job Explorer
Project

lable| »

ime | EndTime

U

rtTime d )
2017-02.
n REL3692

sql_optimizer.dual

ADHOC_SINK 3693
FS: output: None

If you have the Log view URL of a job, you can select MaxCompute > Open Logview from the

menu to go to the details page of the job.



Develop a MapReduce program and UDF program
MaxCompute Studio also allows you to develop MapReduce and Java UDF programs.
Connect to a MaxCompute client

MaxCompute Studio is integrated with the MaxCompute Client of the latest version. Alternatively,
you can specify the path of the locally installed MaxCompute client on the Configuration page of

MaxCompute Studio.

On the Project Explorer, right-click a project and select Open in Console to open the

MaxCompute Console window.

MaxCompute Console

naba Cloud Computing Co., Ltd. ALL rights reserved.

% 6 TODO x| Terminal MaxCompute Console Running Info

Next step

Now, you know the functional interfaces and common application scenarios of MaxCompute
Studio. Continue to the next tutorial. In this tutorial, you will learn how to install MaxCompute

Studio. For more information, see Install IntelliJ IDEA.

2.2 Project space connection management

MaxCompute One of the core features of MaxCompute Studio is to browse resources of a
MaxCompute project, including Table, UDF, and Resource. To realize this feature, create a

project connection first.
Prerequisites

To display Tool Windows of IntelliJ IDEA, you must open an Intellid IDEA project, and the
MaxCompute Project must be configured on IntelliJ IDEA using MaxCompute Project Explorer in
Tool Windows. Therefore, before creating a MaxCompute Project connection, add or import an

IntelliJ IDEA project. This document uses adding a project under Windows as an example.

Open Intellid IDEA, click New > Project, select MaxCompute Studio on the displayed page, and

click Next.
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B wyFirtProject CAbhert b PR deaProect Wy Firsproje - il IEA

New

Edit View MNavigate Code Analyze Refactor

Build Run Tools WCS Window MaxCompute Help

Export to Eclipse...
Export to Zip File...
Settings Repository...

= Open.. Project from Existing Sources..
Open Recent 3 Project from Version Control
Close Project Medule...
9F Settings... Ctrl+Alt+5 Maodule from Existing Sources...
Eg Project Structure... Cerl+Ale+Shift+5 | & Scratch File Ctrl +Alt+5Shift+Insert
Other Settings * gxs FXML File
Import Settings...
Export Settings...

& Save All
£2 Synchronize

Invalidate Caches / Restart...

Crl+Alt+Y

Ctrl+5

B Print...

Line Separators

Power Save Mode

Exit

% Java

'3 Java FX

& Android

(%= Intelli) Platform Plugin

Additional Libraries and Frameworks:

@hewties o s

1 Maven
(* Gradle

G Groovy
7 Griffon

K kotlin

"% Empty Project

ﬂ MaxCompute Java

o MaxCompute Studio

Mothing to show

| Previous |

| Cancel

e

Enter the project name, and click Finish.
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MNew Project
Project name: MyFirstProject
Project location: | C\Users\Administrator\ldeaProjects\MyFirstProject
¥ More Settings
Module name: MyFirstProject
Content root: ChUsers\Administrator\ldeaProjects\MyFirstProject
Module file location: Ci\Users\Administrator\ldeaProjects\MyFirstProject
Project format: Jidea (directory based) v
Previous Cancel Help

il

Create a MaxCompute Project Connection

We recommend that you configure the MaxCompute project connection according to your region
strictly. Otherwise, some errors may occur.

Procedure

1. Click view, select Tool Windows.

2. Click Project Explorer.
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e e
roject [C:\Users\wb—wd41999m]deapmjects\M;F¥s-thjed] -

Mavigate Code Analyze Refactor Build Run Tools VCS Window MaxCompute Help

Too | Windows

1 Favorites Alt+2

Recent Files Ctrl+E

Recently Changed Files  Cirl+Shift=E "7 Alt+4
Recent Changes Alt+Shift+C #¢ Debug Alt+5
TODO Alt+6
Quick Switch Scheme... Ctrl+~ T
Structure Alt+7
Toolbar %" Version Control Alt+9
Toal Buttons ¥ Ant Build
L © Capture Analysis
+ Mayvigation Bar

A Capture Tool
Bidi Text Direction 3 *A Console

Enter Presentation Mode Bl Designer

Enter Distraction Free Mode | Event Log
Enter Full Screen % Image Layers
%\ Job Explorer
M Maven Projects
= Palette

= Palette

Project Explorer
Terminal Alt+F12
@ Theme Preview
[# UI Designer

3. Click plus sign + at the upper left corner to add a MaxCompute project.

m MyFirstProject [CAU Broject @W elli) IDES
File Edit View Mavigate Code Analyze Refactor Buld Run Tools WVCS5 Window MaxCompute

+ MyFirstProject |

Project Explorer &~ 1

g =007
Add project from dataworks  [Esl

q Add project from acces-sldﬂ(eg,rl

4. In the Add MaxCompute Project dialog box, set configuration options.

=] Note:

» Click question mark (?) at the lower left corner of the dialog box to go to the online
document page.
 If the synchronization times out, you can consider increasing the time-out duration for

synchronizing metadata to the local host on the Setting tab.

12
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5. After the preceding settings, click OK. Information about the MaxCompute project is displayed
on the left of MaxCompute Project Explorer. You can click Tables, Views, Functions, and
Resources to view tables, views, functions, and resources of the project.

_—hJ_ ol " — - S— S ——————
File Edit View MNavigate Code Analyze Refactor Build Run Tools VCS Window MaxCompute
/. MyFirstProject

Project Explorer - 2 i
+ I 002

htlp ,.I’,.Fs:ervlce odps.aliyun.com/api

v TB] MyFirstProjectWdhh

» [E Tables & Views

> m Functions
FE Resources

View and modify a MaxCompute connection

In MaxCompute Project Explorer, right-click a MaxCompupte project and select Show|Modify
project properties.

Bl MyFirstProject [Ciibark mei ik MeaProjects\MyFirstProject] - Intell IDEA T

File Edit View Mavigate Code Analyze Refactor Build Run Tools VCE Window

. MyFirstProject
Project Explorer - A

+ - O = 0D 7
w Y http://service.odps.aliyun.com/api

W MyFirstProjectWdhgs -
> [E Tables & Views Add project .
> [f Functions Remove prql'ect
. E Resources rc|| ect F_urcu[;_uprﬂp,
o
s Refresh meta
o
3 .
2 Open in Console
‘:'; Mew sqgl editor
Create a new table
=
o
o
o
—il
'm

In the displayed dialog box, you can view or modify connections and settings of the MaxCompute

project.
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Subsequent operations

Now, you know how to create and manage a project connection. You can continue to the next
tutorial. In the tutorial, you will learn how to query metadata, clear data, and upload and download

data to manage data and resources. For more information, see Manage data and resources.

2.3 Tools Installation and version history

2.3.1 Install IntelliJ IDEA

This document describes how to install the basic platform IntelliJ IDEA of MaxCompute Studio.

Context

Procedure

Procedure
1. Click here to download the Intellid IDEA of the version corresponding to your operating system
(Windows, macQOS, or Linux). The following assumes that the Windows operating system is
used.
Download Intellid IDEA 14.1.4 or a later version. (The Ultimate version, PyCharm version, and
free Community version are supported.)
2. After the download is complete, double-click the installation program to enter the installation

page, and click Next, as shown in the following figure.


https://www.jetbrains.com/idea/?spm=5176.doc50889.2.1.0ohIYs

r Intelli) IDEA Community Edition Setup o || = || £3 |‘

1J Welcome to Intellid IDEA Community
Edition Setup

Setup will guide you through the installation of Intellil IDEA
Community Edition.

Itis recommended that you dose all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer,

Click Mext to continue.

Mext = Cancel

3. Specify the installation directory, and click Next, as shown in the following figure.

Intelli) IDEA Community Edition Setup o | = | &=
Chooze Install Leocation
Choase the folder in which to install Intelli] IDEA Community
Edition.

Setup will install Intelli] IDEA Community Edition in the following folder. To install in a different
folder, did: Browse and select another folder. Click Mext to continue,

Destination Folder

rogram Files\JetBrains\Intelli] IDEA Community Edition 2015, 1.4

Space required: 926.9 MB
Space available: 121.8 GB

<Back || MNext> | [ cancel




4. Select the 32-bit or 64-bit IntelliJ IDEA based on the version of the local operating system.
You can query the local operating system version by following these steps:

a) Open Windows Resource Manager, right-click Computer and select Properties from the

shortcut menu. as shown in the following figure.

b) In the displayed window, check the type of the operating system.

5. Select the corresponding system type and click Next , as shown in the following figure.

ER Intelli) IDEA Community Edition Setup (o] = | |
Installation Options
Canfigure your Intelil IDEA Community Edition installation
Create Desktop Shortout
[] 32-bit launcher | &4-hit Iaun::herl
Create Assodations
[].java [].groovy ] .kt
< Bacdk ]I Mext = I [ Cancel

6. Click Install to start installation, as shown in the following figure.
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ER Intelli) IDEA Community Edition Setup
Choosze Start Menu Folder

ENENES

Choose a Start Menu folder for the Intellil IDEA Community
Edition shortouts.,

Select the Start Menu folder in which you would like to create the program's shortouts, You

can also enter a name to create a new folder.

JetBrains

Accessories
Administrative Tools
Cisco

Edipse

Games

Git

Java

Maintenance
Microsoft Office 2013
MySQL-Front
Motepad ++

Cieygen XML Editor 13, 1 (64-hit)

< Back

s | [ cancel |

Intelli) IDEA Community Edition Setup

Installing

installed.

Flease wait while Intellil IDEA Community Edition is being

=]l B ] 2

Extract: btn_togale_off_focused_holo_dark.9.png... 100%:

- 0™

< Badk

Mext = Cancel

7. After the installation is complete, click Finish.
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ER Intelli) IDEA Community Edition Setup o | = | = |

Completing IntelliJ IDEA Community
Edition Setup

Intellil IDEA Community Edition has been installed on your
computer,

Click Finish to dose Setup.

[]Run Inteli] IDEA Community Edition

< Badk Cancel

What's next

Now you know how to install Intellid IDEA. Continue to the next tutorial. In this tutorial, you

will learn how to install the MaxCompute Studio plugin. For more information, see Install the

MaxCompute Studio plugin.

2.3.2 Installation procedure

Environment requirements

Intellid IDEA can be installed on Windows, Mac, Linux. For more information about the hardware

and system environment requirements, click here . IntelliJ IDEA-based MaxCompute Studio can

also be installed on clients running these operating systems.

MaxCompute Studio has the following requirements on the your environment:

A client running Windows, macOS, or Linux.

Intellid IDEA 14.1.4 or a later version is installed. (The Ultimate version, PyCharm version, and
free Community version are supported.)

JRE 1.8 is installed. (JRE 1.8 has been bound to the latest IntelliJ IDEA.)

JDK 1.8 is installed. (Optional: JDK is required if you need to develop and debug Java UDF.)


https://www.jetbrains.com/help/idea/2016.3/requirements-for-intellij-idea.html
https://www.jetbrains.com/idea/download/

Note:
The client supports JDK 1.9 from the 0.28.0 version. The previous version only supports JDK
1.8.

Installation method

MaxCompute Studio is a plugin of IntelliJ IDEA, which can be installed using either of the following

two methods:

* Online installation using the plugin library (recommended)

+ Installation using a local file
Online installation (recommended)

MaxCompute Studio The MaxCompute Studio plugin has been opened for all users on the Internet
. You can install MaxCompute Studio using the official Intellid IDEA plugin library.

Procedure

1. Open the plugin configuration page on IntelliJ IDEA. (If you are a Windows/Linux user,
choose File > Settings > > Plugins. If you are a macOS user, choose IntelliJ IDEA >
Preferences > Plugins ).

2. Click Browse repositories... and search for MaxConput e St udi o.

3. On the MaxCompute Studio plugin page, click Install.

4. After the installation is confirmed, restart IntelliJ IDEA to complete installation.
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Local installation

MaxCompute Studio MaxCompute Studio can also be installed in a local environment.

Procedure

1. Go to the MaxCompute Studio plugin page to download the plugin package.

2. Run Intellid IDEA.

» If you access IntelliJ IDEA for the first time, a welcome page is displayed. Click Configure

and select Plugins from the shortcut menu, as shown in the following figure.
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IntelliJ IDEA

WVersion 2017.1.5

3¢ Create New Project
1 Import Project
= Open

¥ Check out from Version Control

& Conﬁguru Get Help «

Plugins

Import Settings
Export Settings
Settings Repository...
Check for Update
Project Defaults

* If you have accessed IntelliJ IDEA before, choose File > Settings > Plugins to enter the

same page, as shown in the following figure.

5 A [Mweinlosal v| B 5 G ® m O CIsignin

WaeHlvE S SR RN RIS

& Pried...
Associate with Fle Type...
Power Save Made

Exit
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Q- Plugins
» Appearance & Behavior Q- Show: | All plugins
keymap Sort by: name * | Android Support

> Editor - Android Support

Version Control

Supports development of Android applications with IntelliJ IDEA
and Android Studio

v

' Bytecode Viewer

w

Build, Execution, Deployment

a Copyright
>
Languages & Frameworks . Coverage
» Tools .
m CVS Integration
> MaxCompute Studio : .
& Eclipse Integration

Vim Emulation

& EditorConfig

& Git Integration
& GitHub
., Gradle
m Groovy
& [18n for Java

& IdeaVim
a Intellilang
a Java Bytecode Decompiler
w Java Stream Debugger
= lavaFX [
Check or uncheck a plugin to enable or disable it.
Install JetBrains plugin... Browse repositories... Install plugin from disk...

o

Settings @

3. On the Plugins page, click Install plugin from disk..., as shown in the following figure.
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ﬁ

Plugins
& S A |
Sort by:name ¥ | Android Support
Android Support
L Ant Support Supports developmant o Androld applications wit Intell IDEA
(“a Bytecode Viewer
(“a Copyright
(s Coverage
“a CVS Integration
(“a Eclipse Integration
(“g EditorConfig
(g Git Integration
(", GitHub
(g Gradle
(g Groowy
(g 118n for Java
(“a IdeaVim
(“a IntelliLang
(“a Java Bytecode Decompiler
(“g Java Stream Debugger
(O JavaFY &2
Check or uncheck a plugin to enable or disable it.
Install JetBrains plugin... | | Browse repositories... | I Install plugin from disk... I
[ oc || cancel

4. In the displayed window, click the gray icon before a directory for navigation, find the plugin file,

select it, and click OK.
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Choose Plugin File

JAR and ZIP archives are accepted

(=]

a | m x | 5

functionstudio
jargl
Ksoftware
KwDownload
MCStudioEE
MININT
rysql
Program Files
Program Files (x86)
Users
=l
BEaEE R
» eclipsefEifF
W Intell) IDEA

{ WOOWE W W W W W W W W W

,G.E

# ME\Intell) IDEA\odps-studio-intellij-3.0.2_20181126174744.zip | +

Hide path

|| odps-studio-intellij-3.0.2_20181126174744.zip

> Bmp

Crag and drop a file into the space above to quickly locste it in the tree

OK

Cancel

5. Return to the Plugins page and click OK to install the local plugin.
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Settings =]
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* Tools a GitHub warehouse and big data modeling service.
> MaxCompute Studio
P a Gradle MaxCompute Studio is a plugin for IntelliJ platiorm allowing
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ympute Studio
Check or uncheck a plugin to enable or disable it

Install JetBrains plugin... Browse repositories... Install plugin from disk...

7] Cancel Apply

6. After the installation is complete, a dialog box is displayed, prompting you to restart Intelli

IDEA. Click Restart.
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Restart || Postpone |

7. After IntelliJ IDEA is restarted, the page is displayed as shown in the following figure.

Fle Edit View Mavigate e Analyze Befactor Build Run Teols WCS Window MaxCompute
glhjmixplw

S+ - DG ¥ I OO
;l“lﬂmﬂ-ﬁ*ﬁ-—ilpi

The shorteuts such as Ctrl+0 (View | Quick Documantation], Ctrl+f (View |
Parameter Info), Ctr1+6 (Navigate | Dedaration) and others can be used not only in
the editor but in the code completion popup list as well.

catehilns
€ b UnsatisfiedLinkError (java.lang) L
* ‘& UnsupportedLockandFeelBxception [ javax.s.
Documentation for UnsatisfiedLinkError A
& Pt M<17> &
javalang l

public class java. UnsatisfiedLinkError
axtands m.im.;m‘m:.m

= Job Explorer

[Z] Show tips on startup | PreviousTip || NextTip |  Close |

 Structure
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Next step

Now, you know how to install the MaxCompute Studio plugin. Continue to the next tutorial. In the
tutorial, you will learn how to configure a MaxCompute project connection to manage data and

resources. For more information, see Create a MaxCompute project connection.

2.3.3 View and upgrade the version
View the MaxCompute Studio version
Perform the following steps to view the Studio version:

1. Go to the Settings/Preferences page (by pressing Ctrl - Al t - Sin Windows or g in macOS).
2. Select Plugins on the left bar of the dialog box and search for MaxCompute Studio.

3. View the MaxCompute Studio version number and release information.

Alternatively, you can select MaxCompute Studio on the left bar of the Settings page to view

the current version number.
Check new versions

By default, MaxCompute Studio automatically detects new versions. If a new version is available,

MaxCompute Studio automatically notifies you.
After receiving an update prompt, you can select:

» Install: Click the Install link in the update prompt. The new version is automatically downloaded

and installed. After the installation is complete, restart IntelliJ IDEA.

» Configure: Click the Configure link in the update prompt. You can configure whether to detect

new versions automatically.

If the automatic update function is disabled, you can perform the following steps to check and

install a new version of MaxCompute Studio.

1. Go to the Settings/Preferences page (by pressing Ctrl - Al t - Sin Windows or g in macOS).
2. Select MaxCompute Studio on the left bar of the dialog box.

3. On the MaxCompute Studio configuration page, click Check new versions.

4

. If a new available version is detected, Studio notifies you of the new version number. Click

Install new version and restart IntelliJ IDEA to complete installation.

You can use the Automatically checks for new version check box to control the switch for

automatic version update check.



Next step

Create a MaxCompute project connection

2.4 Manage data and resources

2.4.1 View tables and UDF

View tables and functionsView tables and functions

In the Project Explorer window, you can view tables, functions, and resources with connections
added. For tables and functions to be viewed in the Project Explorer window, the MaxCompute
project connections must be added, for more information, see Add MaxCompute project

connections.
Browse tables and functions
To browse tables and functions in the project space, follow these steps.

1. Open the Project Explorer window and you can view the added Project node tree.

‘MaxCompute Project Explorer

b

+ - O T = O ?

(3] odps_studio_dev|

[H Tables & Views
[~ ] Functions
[ Resources

The toolbar is displayed at the top of the node tree, and includes:

+ Add Project: Adds a connection to the MaxCompute project space.

+ Delete Project: Deletes a connection from Project Explorer, which has no impact on the

project space on the server end.

+ Update Metadata: Updates metadata information from the project space on the server end

and updates the locally buffered metadata.
+ Expand Node: Expands all tree nodes.
* Fold Node: Folds all tree nodes.
» User Feedback: Submits user feedback.
* Online Documentation: Opens online documents.

2. Double-click the Tables node or click the drop-down arrow to expand the Tables node to list

all tables in the project (including virtual views). The table name list serves the same purpose



as the show tables command. You must have the List Table permission in the project. The

methods for the Functions and Resources nodes are similar to that of the Tables node.

P] odps_studio_dev
B=Tables & Views |
alitrip_dest_relation
array_map_test2
haoping_sdk_log_copy
haoping_test_part

] Functions

[T Resources!

3. MaxCompute Studio downloads project metadata on the server to the local device. When
metadata on the server end is updated, for example, a new table is added, you must manually
trigger a refresh to reload changed metadata to the local device. The refresh can be performed

at the Project or Table level. The procedure is as follows:

a. Select a node.

b. Click the Refresh icon on the toolbar or right-click the node and select Refresh meta.

MaxCompute Project Explorer - A\

+-[g]lz=z 002
?E odps_studio_dev
;?Ebles = Add project

alitri
PYe® | Refresh meta [

haop open specific entity
haoping_test_part
hy_testl

HH key

View table details
You can view data table information in Table Details View of MaxCompute Studio.

1. In the node tree, expand a table node to view the column name and type.



[P| odps_studio_dev
IﬁTahles & Views

F
-
F

id :STRING

hy_testl
key
table_test
[~ ] Functions

=l Resources

alitrip_dest_relation

arrays :ARRAY <STRING=
H maps :MAP<STRING,STRING=
haﬂplng sdk_log_copy
haoping_test_part

2. Double-click a table or right-click a table and choose Show Table Detail to view the table

details. The table details include metadata, such as owner, size, and column, table structure

information, and data preview.

VaxCompute P forer Bl avaethodr

&
&

K EPSHRIGERSSIR] 5 b_hour x

Table schema

b_hour

Ela 0101020223 stgcontrol_395
fE] studiotest1_testl

[ Tables & Views 1830820614534790

2016-02-18 15:20:46
2016-04-18 16:48:18
2016-08-05 10:18:33

g5098%

[ hour :STRING
[ ¢ STRING
[ d STRING
[ e STRING
[ FSTRING Sh
[ g STRING Sh

e
FE3L

g

STRING
STRING
STRING
STRING
STRING
STRING
STRING

type

comments,

Eh STRINC

e {eleelelelelelelelelelelelelel:lel

EEEEEEEEEEEEEEEEEEEE

(el el felel el el felelel effelelelel

EEEEEEEEEREEEEEEEEEE
EEEEEEEEEEEEEEEEEEEE

3. Right-click Tables & Views and select Open specific entity to display the details of the

specific table. Note that the complete table name must be specified.

If you do not have the List

permission on the project and only have the permission on a specific table, you can also view

details of the table using this method. The methods for the Functions and Resources nodes

are similar to that of the Tables node.



MaxCompute Project Explorer

+ -0 TF OD?
?ﬂ odps_studio_dev

"Func Add project

o [ Resc Refresh meta

P| wpp_ds —
%] cdo_m i Open specific entity
?ﬂ studiotest]_testl

o Open specific table %

Name:|| I

o JRE

Intellij IDEA supports searching by default. After a table is expanded, you can directly press
keys on the keyboard to perform fuzzy match.

. MaxCompute Studio also supports quick search for the table, you can use the shortcut key (
Windows: Ctrl + Alt + Shift + N, macOS: ~= + & + O) to call the navigation bar, then enter the

name of the table and press Enter.

Enter symbol name: Include non-project symbols (\X380) T

Q_hyl Q)

hy_partition_test odps_studio_dev

m_test odps_studio_dev

hy_view odps_studio _dev

You can narrow the search by using the pre-keyword (table:, function:, or resource:). For

example, to search for the function count, enter function:count.

5. To know the scripts in which the table is used, right-click the table and select Find usages.

BT " F ™ S0 %l w00 et

hytestl Add project

Find usages

Refresh table meta



View function details

1. Expand a function node under the UserDefined node of Functions to display the method
signature of this function. Double-click a function node under the Functions node. Alternatively,
double-click the source code resource of the function under the Resources node. In this case,

codes of this function are displayed.

<+ MaxCompute Project Explorer 8- 1+ [ JavaMethodFunction. java = g PlusHello.class x
F g P X . . .
t|l + — f_T ix T Decompiled .class file, bytecode version: 50.0 (Java 6)
: E meta_dev 1 '/
%‘E a_0101020223_stgcontral_395 g // Source .'.'Gll.“.‘e ;ec-"ef:eo‘ 1 ;G"-‘ a .class file by Intellid IDEA
— R by Fernflower decompiler)

u {F] studiotest1_test1 4 : )
2 [ Tables & Views 5
3
E [ Functions 6 package myudf;
' L 7
~ x divideerror . )
+ f 8 import com.aliyun.odps.udf.UDF;

fx myudtf 9

j2dplushello 1@ public class PlusHello extends UDF {
g fx plushello(STRING):STRING “ public PlusHello() {
i fx timestwo .‘g }
g 1
s [Z] Resources 14 public 5tring evaluate(String a) { return "hello" + a; }
3 17 }
|- 18

3

= | Note:

The Java code is obtained by decompiling JAR, which is not the source code. To enable

the Python UDF to parse the signature, install PyODPS (MaxCompute Python SDK) first.
Install pi p: sudo/ usr/ bi n/ pyt hon get - pi p. py (Download get - pi p. py from Google
manually) and then PyODPS: sudo/ usr/bi n/ python -m pip install PyODPS. Note
that the Mac operating system has Python, which is stored in /usr/bin/python. Install PyODPS
in this directory.

2. The classification under the Builtin node of Functions shows the built-in functions of the

system, expand it to display signature and double-click it to display function document.

2.4.2 Import and export data
MaxCompute Studio can import local data files in CSV or TSV format to MaxCompute tables and
export MaxCompute table data to local files. MaxCompute Studio completes data import and

export by using Batch data Tunnel provided by the MaxCompute platform.
Usage instructions

+ The MaxCompute Tunnel service must be used for data import and export. Therefore, the

MaxCompute project added in Studio must be configured with the Tunnel service.

* Related permissions must be granted for table import and export.
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Import data

1. Open the Project Explorer window, right-click a table name or a field attribute in Data preview

of Table details and select Import Data Into Table.

File Edit View MNavigate Code Analyze Refactor Build Run Tools WVCS Window
% Local Settings
Project Explorer - A0

+ - ORES ¥ T OO ?
w Y4 http://service.odps.aliyun.com/api
v P] MySecondProject2
v [ Tables & Views
> [E bank_data
Eemp_test_new

FH ods_user info_d

r'EsuIt_t' '
EH result | Q STIUEIIE
i table__l 5 User Privilege

»

>

»

»

>

> H W‘f_l.nl [T Refresh table meta
> [f Functions | 55 o1y table detail
> [ Resources

5] Open table editor

Generate select statement

Generate DDL statement

Truncate table data
(=) Drop table from server

Import data into table

Export data from table

2. In the Import Data dialog box that appears, select the path of the imported data file, column

separator, size limitation, and number of lines for an error tolerance, and click OK .
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¥ 1P| odps_studio_dev

v [@Tables & Views
alitrip_dest_relation
array_map_test2
haoping_sdk_log_copy

haoEing_test_part

ke Add project

tal Refresh table meta

> a Resou Show table details

?ﬂ wpp_dev Delete table from server

>
> ?E' cdo_meté Generate select statement
» P studiotes

| Import data into table

Export data from table

3. If Import Data Success is displayed, data import is successful and imported data can be

viewed in the table.

Export data

1. Two methods are provided for table data export.

* Right-click a table name and select Export Data From Table.

+ - ORS %

=T 00O 7

v {P] MySecondProject2

v [& Tables & Views
> [E] bank_data

> E emp_test_new
bl ods user info
3 [ result_tabl
3 [ result_table
> [E]table 1
> B weinl

» mFunctl'ons

> [ Resources

~ W hitp://service.odps.aliyun.com/fapi

) Find usages

%5 User Privilege

[7 Refresh table meta
&l Show table detail

E5] Open table editor
Generate select staterment

Generate DDL statement

Truncate table data
() Drop table from server

Import data into table

Export data from table
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* Right-click a field attribute in Data Preview of Table details and select Export Data From

Table.
ghy_testl % |
Table information ; Table schema
key value e name type comments
Name: hy_testl 4 lid BIGINT
Comments: i Iname STRING
Owner: ALIYUN$dxp_06894684@aliyun.com

Created time: 2016-12-29 11:50:22
2016-12-29 11:50:22

2017-01-22 20:42:37

Meta Modified time:
Data Modified time:

Size: 1280
Physical size: 3840
Partitions: 0
Partition columns

Sharding:

Sharding columns:

il lage BIGINT

aw

Data preview

1

id
4 Export data from table

Import data into table

0 age ‘
11
_

2. In the Export Data dialog box that appears, select the path for saving the exported data file,

column separator, size limitation, and number of lines for an error tolerance, and click OK.

+ - ®m?

?E odps_studio_dev
[@Tables & Views
i alitrip_dest_relation
array_map_test2
it haoping_sdk_log_copy
haoping_test_part

=
[
3]

B ke Add project
EH tal Refresh table meta

Functi .
ﬁ;g;(‘ Show table details

fx ex2 Delete table from server

frhac Generate select statement
fx hac
fx hell Import data into table

EEsEl Export data from table

Ry

3. If Export Data Success is displayed, data export is successful and exported data can be

viewed in the target file.

You can also right-click Data Preview of Table and choose Export Grid Data to export data.



ahy testl x

Table information

L3

4 Table schema

key
Name:
Comments:
Owner:
Created time:
Meta Modified time:
Data Modified time:
Size:
Physical size:
Partitions:
Partition columns
Sharding:
Sharding columns:

value
hy_testl

ALIYUNS$dxp_06834684@aliyun.com
2016-12-29 11:50:22

2016-12-29 11:50:22

2017-01-22 20:42:37

1280

3840

0

name
id

name

age

type comments
BIGINT
STRING
BIGINT

.

Data preview

1
1

E] Note:

Copy cell content

Export grid data

View cell text

name

age

The Data Preview function in Data preview is used only to export data displayed in Data sample

instead of all data in the table.

New Type Import Export

Simply generate text in the agreed format and store it in CSV or TSV format, you can import to

table through studio.

Conversion rules for each data type are described in detail below.

Basic Type

1. Tinyint, smallint, Int, bigint is stored directly as an integer string, and the numeric value exceeds

the type boundary is reported as wrong

2. Float, double to store fractional strings or floating-point forms, such as: 2.342 1x + 7

w

and no errors will be reported

N o o &

String is stored directly as a string

format mismatches will be reported incorrectly

Decimal string that supports shaping or floating-point

Binary needs to encode binary data to base64 string

Varchar is stored directly as a string, which is automatically truncated above the upper limit,

Datetime date time requires that the format specified in import dialog is consistent and that the

8. Timestamp timestamp needs to follow yyyy-[m] M-[d] d hh \: mm \: ss [. f...] Format is stored as

a string

9. Boolean true or false string?

Composite Type



1. Array needs to be stored as a JSON array. The array elements are converted to strings

according to the rules agreed in this article, array elements support any type.

2. Map needs to be stored as a JSON object, and map key, value are converted to a string

according to the rules agreed in this article, value supports any type of nesting.

3. Struct needs to be stored as a JSON object, the struct field name is string, and the key
converted to a JSON object, strect field values converted to JSON The value of the object, the

value of the field that defines the rule transformation in this article.
Example
Array type

For Table structures as follows:

Column name Column data types

c 1 ARRAY<TINYINT>

c 2 ARRAY<INT>

c_3 ARRAY<FLOAT>

c 4 ARRAY<DATETIME>
c 6 ARRAY<TIMESTAMP>
c 7 ARRAY<STRING>

You can import data in the CSV format shown below:

c 1l,c 2,c 3,c4,c6,c 7

I R [ e e A I [ T~
o""]1 ", "[" "3-00:00:00", "3-5-00:00:00 "", "O0O0:00:00", "[" At 00:00:
00. 123456789 "", "At 00:00:00. 123456789 "", "At 00:00: 00. 123456789

"ttt ["AAAT )" Steanboat "M, "4C' "]
B R R e T R - S T I A 0
e, t[""2017-11-11 00: 00: 00"",""2017-11-11 00:00:00"",""2017-11-11
00: 00: 00""]","[""2017-11-11 00: 00: 00. 123456789"", ""2017-11-11 00: 00: 00
. 123456789"",""2017-11-11 00: 00: 00. 123456789""]","[""aaa"", ""bbb"", 6 ""
ccc""]"
R R e T [ R S I I A O
e, t[""2017-11-11 00: 00: 00"",""2017-11-11 00:00:00"",""2017-11-11
00: 00: 00""]","[""2017-11-11 00: 00: 00. 123456789"", ""2017-11-11 00: 00: 00
.123456789"", ""2017-11-11 00: 00: 00. 123456789""]1","[""aaa"", ""bbb"", 6 ""
ccc""]"

Note:

The CSV format needs to escape double quotes, which are expressed by two double quotes, you

can refer specifically to the CSV format specification.



Map Type

For Table structures as follows:

Column name Column data types

c_1 MAP<TINYINT,STRING>

c 2 MAP<STRING,INT>

c 3 MAP<FLOAT,STRING>

c_4 MAP<STRING,DATETIME>
c_5 MAP<STRING,STRING>

c 6 MAP<TIMESTAMP,STRING>

You can import data in the CSV format shown below:

c l,c 2,c 3, c4,c5c b6
“{1:." "2345" "}, "{" 123 "". "2",
o102 1112 Uttty ottt "AAAT M
"11 00:00: 00" "," Steanboat "":
n , n {ll n
123456789 "": " AAA"
“{1." "2345" "}, “{"
", 1.2:" 1111 "},
"11 00:00: 00" ","

123 "": "2",
St eanboat "":

123456789 "": "AAA" " "

3" "4 Uiy
“hubl11l 00: 00: 00 "",
"00: 00: 00"} "," ckey "":
hub11l 01: 00: 00. 123456789 ""
"," 027 11 00: 01:

“{" "AAA" ":" "hubll 00: 00:00 "",
"00: 00: 00"} "," ckey "":
" {"" hubll 01:00: 00. 123456789 "":
027 11 00: 01: 00. 123456789 "":

"223445"
"4C' ":" China
"cval ue"}
"hubl1l 00: 00: 00.
123456789 "": "DDD ""}"
"4 "ty "{2.0:" "223445"
"4C' ":" China
"cval ue"}
"hubl1l 00: 00: 00.
Ilm IIII}II

"[2.0:"

: "dddd" ","
00.
3" .

"dddd" ","

“{1:""2345" "}, {123 o2, 3t ort4n it {2.0:""223445" 1. 2
:"t1111t},{""aaa"":""2017-11-11 00: 00: 00"",""ccc"":""2017-11-11
00: 00: 00"", ""bbb"":""2017-11-11 00: 00: 00""}","{""ckey"":""cval ue
i, {""2017-11-11 01:00: 00.123456789"": ""dddd"", ""2017-11-11 00: 00:
00. 123456789"": ""aaa"",""2017-11-11 00: 01: 00. 123456789"":""ddd""}"

Struct Type

For Table structures as follows:

Column name

Column data types

C_struct

<RUCT<x:INT,y:VARCHAR(256),z:STRUCT<a
TINYINT,b:STRING>>

You can import data in the CSV format shown below:

c_struct

||{n ||X|| n c nn 1000n 1] , " llyll " : 1] "Va.r Char _t eSt nn , nn le " : {Il " an 1] : nn 123!! 1] , nn bll " : nu

stringdeno""}}"




t{rtxttott1000"t, "yt ""varchar _test"",""z"" " {""a"":""123"",""b""
stringdenp""}}"

2.4.3 Visualization of operating the tables
The Project Explorer of MaxCompute Studio provides the visualized table structure editor used to

create and modify tables.
Visualization of creating a table
Procedure

1. Right-click the project that you want to create the table, and select create a new table.

Project Explorer 8- -

+ - OE%S ¥ £ OO ?
~ Y4 hitpy//service.odps.aliyun.com/api
v TP] MySecondProject2

Yl - | Tables & View

» [ bank data Dpen specific entity

) [ emp_test_ne f_j" Refresh meta
» ods_user_in Create new table
» [ result_tabl
» result table
> [E table 1
» B weinl
¥ E_Q Functions
> [ Resources

2. In the dialog box that appears, enter a table name and column information. Click Generate
CreateTable Statement generates the corresponding pant statement, click Execute to

execute the build table.



HEEF=ANE - [MySecondProject2] 2

B [T el s e
R
e ] =

(kL Aliore fE=iFEE  [RIS=HiERE

#XF1| 231| As SELECT| HihnEtE|

name type not null comment +

id BIGINT

| SOL DDL SCRIPT |

T CREATE TABLE MySecondProject2 . {
= “zoll’ BIGINT)

|®

#=fE 12258 MaxCompute {7~ BG=

When you set the table name, column name, type, and lifecycle, observe the related

requirements of MaxCompute. For more information, see Table Operations.

3. After the table is created, view the table metadata in table&view of the Project Explorer. If no

metadata is displayed, refresh the list.
Visualization of modifying a table
Procedure

1. Intable&view of the Project Explorer, right-click the expected table and select Open table

Editor:



Project Explorer - A0

+ - ORS *« £ OO ?
w YU http://service.odps.aliyun.com/api
v P] MySecondProject2
v [ Tables & Views

> EETEES o .
> emp_test_ne = o UE?EI!EE
» ods_user inf = User Privilege
> result_tabl .[__j' Refresh table meta
> [ result_table = .
- 1 Show table detail
» table_1 & Show table deta
» we_inl Open table editor
> EJ'J Functions Generate select statement
? E’J Resources

Generate DDL statement

Truncate table data

(=) Drop table from server

Import data into table
Export data from table

2. In the dialog box that appears, edit the table. You can modify the table comments, table
lifecycle, column name, and column description, and add columns. Specific rules follow the

MaxCompute table requirements and can be found inTable Operations.



3= - [MySecondProject2.table_2] [=
== table_2 [(EEAFE
2 =5
LrafEEE: -1 =]
=R | 57| F31| K
name type not null comment +
coll BIGINT
col2 BIGINT
cold BIGINT
col3 BIGINT
col3 BIGINT
SQL DDL SCRIPT
ALTER TABLE table_Z ADD COLUMNS ¢ 2
col5  BIGINT):
e 12358 MaxCompute HiT v | SlEEREETE  ~ s T

3. After completing the modifications, click Alter Table Statement Generate a specific alter
statement and click Executeto perform the table modify operation. After successful execution,

view the table metadata.
Visualization of deleting a table

In table&view of theProject Explorer, right-click the expected table and select Drop table from

server:




Project Explorer - A0

+ - ORERS *» £ OO
w YU http://service.odps.aliyun.com/api
W E MySecondProject2
v [ Tables & Views
» bank_data
emp_test_new
ods_user_info_d
result_tabl
result table
fiebie 1 |
table 2 Cl Find usages
wec_inl 3 User Privilege

>

>

>

>

>

>

>
3 % Functions f_j‘ Refresh table meta
> FAR i
esOUrces Gl! Show table detail

Open table editor

Generate select statement

=J

Generate DDL statement

Truncate table data

Drop table from server

Import data into table
Export data from table

Select OKin the bullet box to remove the table from the MaxCompute service.

2.5 Develop SQL procedure

2.5.1 Create MaxCompute Script module

Before developing MaxCompute Script, you need to create a MaxCompute Script module in either

of the following scenarios:
No script file exists locally

If no script file exists locally, you can use Intellij IDEA to create a new module.

Procedure

1. Open or create a MaxCompute Studio project. This article uses creating a project as an

example. Click File in the menu and select New > Project . as shown in the following figure.



Local Settings [CA\Users\AdministratorLocal Settings] - C\Users\AdministratorIdealC
Edit View MNavigate Code Analyze Refactor Build Run Tools WVCS Wind

Open...
Open Recent
Close Project

P Settings...

Cither Settings

Import Settings...
Export Settings...
Export to Eclipse...
Export to Zip File...
Settings Repository...
=l Save All
55 Synchronize
Invalidate Caches / Restart...
Print...

Power Save Mode

Exit

Ctrl +Alt+5

[: Project Structure... Ctrl+Alt+Shift+5

Ctrl+5
Ctrl +AlE+Y

b

Project from Existing Sources...

Project from Version Control »
Meadule...

Module from Existing Sources...

s Scratch File Ctrl+Alt+Shift+Insert
i FXML File

2. Select MaxCompute Studio on the left-side navigation pane, and click Next.



MaxCompute Tools and Downloads / 2 MaxCompute Studio

[ ]

Mew Project
% Java Additional Libraries and Frameworks:
'3 Java FX
i Android
(% Intelli) Platform Plugin

11 Maven Nothing to show

(% Gradle

S Groovy
™ Griffon

K Kotlin

"% Empty Project

W% MaxCompute Java

) MaxCompute Studio

I Mext I | Cancel | | Help

3. Enter the project name, and click Finish.
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-

New Project 2

Project name:  |MySQLProject

Project location: | C\Users\Administrator\ldeaProjects\MySQLPraoject

b More Settings

Previous Cancel Help

@ Note:

If a project has been opened before, a dialog box appears, prompting whether to open the

new project in the existing window (closing the previous project). Click This Window.

-

Mew Project X

E' Mew projects can either be opened in a new window or replace the project in the existing window.
How would you like to open the project?

[] Remember, don't ask again This Window MNew Window

4. After the project is created, the page shown in the following figure appears. You can develop

SQL scripts in the project.



MaxCompute Tools and Downloads / 2 MaxCompute Studio

MySQLProject [C:\Users\Administrator\ldeaProjects\MySQLProject] - Intelli) IDEA
File Edit View Mavigate Code Analyze Refactor Build Run Tools VCS Window MaxCompute He
“\ MysQLProject )

B Project ~ (R - 2
MySQLProject C:\Users\Jdministrator\ldeaProjects

|l External Libraries
G Scratches and Consoles

Script files exist locally

If many scripts have been stored in a local folder, MaxCompute Studio is used to edit the scripts.
You can open a module directly.

Procedure

1. Create a connection configuration file odps_config.ini for MaxCompute in the scripts folder,

and configure authentication information for connecting to MaxCompute.

* project_name=xxXXXXXX
* access_id=XXXXXXXXXX
* access_Kkey=XxXxXxXXXxxx

* end_point=xXXXXXXXXX

2. Open IntelliJ IDEA, select File > > Open, and select the scripts folder.
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Open File or Project == ]

. 2 X | | = Hide path
ChUsers\Administrator\ldeaProjects |':|

> Documents

» Downloads

> eclipse-workspace

» Favorites

W IdeaProjects
v g MyfirstProject
> idea
> [gMyFristModule

v [gscripts

v Jdea
=, modules.xml
m SCripts.iml

o workspace.xml

» target
> warehouse
w WhyfirstProject.iml
Crag and drop a file into the space above to quickly locate it in the tree
a OK Cancel

3. MaxCompute Studio detects whether the odps_config.ini file exists in the folder, captures
metadata on the server based on the configuration information in the file, and compiles all

scripts in the folder.

2.5.2 Write SQL

Table Operations

2.5.3 Submit SQL scripts

MaxCompute Studio directly submits MaxCompute SQL scripts to the server for running, and
displays detailed information about the query result and execution plan. Before submission,
MaxCompute Studio compiles scripts to effectively prevent compilation errors that are detected

after the scripts are submitted to the server.
Prerequisite

* Create a MaxCompute project connection and bind it to the target project.



+ Create a MaxCompute Studio module.
» Before submission, perform setting as required. MaxCompute Studio provides various setting
features. You can perform quick setting on the toolbar at the top of the editor page. The

following three types of setting can be performed:
— Compiler Mode: It can be set to Script Mode or Statement Mode.

m In statement mode, scripts are separated by ; and submitted to the server one by one.
m The script mode is newly developed. A whole script can be submitted to the server
immediately. The server provides overall optimization, which is more efficient. Therefore,
this mode is recommended.
— Type System: It mainly solves the compatibility problem of SQL statements, which can be

set to the following values:

m Legacy TypeSystem: Indicates the type system of original MaxCompute.
m MaxCompute TypeSystem: Indicates the new type system introduced by MaxCompute 2
.0.
m Hive Compatible TypeSystem: Indicates the type system in Hive compatibility mode
introduced by MaxCompute 2.0.
— Compiler Version: MaxCompute Studio provides the stable compiler and experimental

compiler.

m Default Version: Indicates the stable version.

m Flighting Version: Includes the latest features of the compiler.

Note:
You can use Global Settings to set the submitted scripts. Select File > > Settings > >
MaxCompute , select MaxCompute SQL, and choose Compiler > > Submit to set the

preceding attributes.
Submit SQL scripts

The top toolbar of the editor provides the Synchronize and Compile and Submit features.

* **SQynchroni ze**: Updates netadata in SQ scripts, including table
nanes and UDFs. |f MaxConpute Studio pronpts that a table or function
cannot be found, but the table or function obviously exists on the
server, you can use this function to update netadat a.

* **Compile and Submit**: SQL scripts are conpiled or submtted to the
server in conpliance with pre-rel eased MaxConpute SQ. rules. Details



of conpilation errors are displayed in the **MaxConpute Conpil er**
Wi ndow.

Procedure

1. After SQL statements are compiled, click the green running icon on the toolbar, or right-click
Script Editor and select Run MaxCompute SQL Script to submit the SQL statement to the
server. If a variable exists in the SQL statement (such as ${bizdate} in the following figure), a
dialog box is displayed, prompting you to enter the variable value.

2. The script will be locally compiled (depending on the project metadata you added in the Project

Explorer window). If no compilation error exists, the script is submitted to the server for
execution. When the SQL script is being executed, the running logs are displayed. If the script
is running on the server, the Job Details page is displayed, showing the basic information
about job running and the execution diagram.

3. You can view SQL results on the Results page. If there are multiple statements in the single-
sentence mode, the result of each statement is displayed. You can select rows or columns in

the table, and copy them to the Clipboard.

2.6 Developing Java

2.6.1 Create MaxCompute Java Module
MaxCompute Studio supports Java user-defined function (UDF) and MapReduce development.

First, a MaxCompute Java module must be created.
Create a module

ChooseFile > New > Module, set the module type to MaxConput e Java, and configure Java
JDK. Click Next, enter a module name, and click Finish. MaxCompute Studio automatically

creates a Maven module and introduces MaxCompute dependencies.
Module structure

So far, a module for developing a MaxCompute Java program has been established, that is the

mDev shown in the following figure. Its main directories include:

» src/main/java: Source code for Java program development.
+ examples: Sample code, including unit test (UT) examples. You can see the examples to
develop or compile UT.

+ warehouse: Schema and data required for running locally.



B Project - D = | & I+
v o MyfirstProject C:\Users\Administrator\ldeaProjects\M

b Jdea
v MyFristModule
» examples
v Src
W main
b java
resources
> test
» target
m MyFristModule.iml
pom.xml
b scripts
target
w warehouse
v example_project
> __FESOUrces__
w __tables__
b ads_log
¥ kmeans_in
¥ kmeans_out
b pagerank_in
b pagerank_out
? rs_out
b 555p_in
? sssp_out
¥ we_inl
¥ we_in2
? we_out

m MyfirstProject.iml
» |l External Libraries
» [ Scratches and Consoles

2.6.2 Develop and debug UDF

Once the MaxCompute Java Module has been created, udfs can be developed.
Procedure

1. Expand the MaxCompute Java Module Directory that you created and navigate to src > main >

java > new, and click MaxCompute Java as shown in the following figure.



MaxCompute

Tools and Downloads / 2 MaxCompute Studio

« MyfirstProject )

& Project -

Jidea
& MyFristModule

examples

>

b

>
v src
main
Zresources
> test
target

u MyFristMaodule.in

b

M pom.axml

scripts

target

warehouse
example_project

__resources_

_tables__
ads_log
kmeans_in
kmeans_o
pagerank,
pagerank,
rs_out
sssp_in
sssp_out

we_inl

WO W W W W W W W Y

we_in2
> we_out
u MyfirstProject.iml

|Illl External Libraries
[ Scratches and Consoles|

>
>

[} MaxCompute Java is use

v % MyfirstProject Ci\Users\Administrator\IdeaProjects\

'3

scripts ) B MyFirstSQL.osgl

D £ | B

Bl MyFirstsQL.osql |

| saEst |

MaxCompute£BEG; v | | BRASE

——name MyFirst50L

o6 Cut Cirl+X
= Copy Ctrl+C
Copy Path Ctrl +Shift+C

Copy Reference Ctrl +Alt+Shift+C

E Paste Ctrl+V
Find Usages Ale+F7
Find in Path...

Replace in Path... Ctrl+Shife+R

Analyze >
Refactor

Add to Favorites

Show Image Thumbnails Ctrl+Shift+T
Reformat Code Ctrl+Alt+L
Optimize Imports Ctrl+Alt+0
Delete... Delete

Build Madule 'MyFristModule'

Rebuild '=default=" Ctrl+5Shift+F9
P> Run 'All Tests' Ctrl+Shift+F10
§E Debug "All Tests'
¥ Run ‘All Tests' with Coverage

¢ Kotlin File/Class
File

= Scratch File

i FXML File

package-info.java

Ctrl+Alt+5hift+Insert

i

MaxCompute SQL B
MaxCompute ZEEF.EE
HTML File
JavaFXApplication

H
d
i Singleton

& Gradle Kotlin DSL Build Script
& Gradle Kotlin DSL Settings

@1 XSLT Stylesheet
Edit File Templates...
GUI Form
Dialog
Form Snapshot
11 Resource Bundle
Plugin Devkit

[#¥] Create 'All Tests'..
Show in Explorer
Open in terminal

B set MaxCompute project
Local History

D Synchronize java'
Directory Path Ctrl +Alt+F12

+* Compare With... Ctrl+D

Open Module Settings F4

Load/Unload Maodules...

Mark Directory as

&) Create Gist...

2. Set Name and Kind, and click OK. as shown in the following figure.
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I =

Create new MaxCompute java class @

Mame: | MyFirstUDF Tl

Kind: | uck LIDF V|
B upar

EE upTF —
&¥ Driver

@ Mapper

¥ Reducer

5 StorageHandler

I\ Extractor

» Name: Specifies the name of the MaxCompute Java Class. If you have not created a
package, you can enter packagename.classname to automatically create a package.

» Kind: Specifies the type. Supported types include custom functions (UDF/UDAF/UDTF),
MapReduce (Driver/Mapper/Reducer), and non-structural development (StorageHandler/

Extractor).

3. After the creation is successful, the Java program can be developed, modified, and tested.

« MyfirstProject ; ['; MyFristModule ) 15 src ) [ main ; [ java ; € MyFirstUDF B | WA MyFirsts
[ Project ~ @ = | %~ 1+ | BJMyFirstSQLosgl € MyFirstUDFjava
v Wb MyfirstProject Ci\Users\Administrator\ldeaProjects\M Project SDK is not defined

> idea

3 import com aliym odps udf UDF;
- MyFristModule

> Bexamples

v sre / TODQ defi
~ miﬂ publie String
v [ java ¥
» (€ HelloDriver

v € MyFirstUDF =

m evaluate(Strin

parameters and return type, e. g public String evaluate (String a, String b)
aluate (String s) { return "hello world:” + s: }

resources

@ Note:

Here's a code template that can be customized in Intellij. You can define it in Preference >

Editor > File > Code Templates. Then look for the corresponding template in the Code tab.

For detailed development steps, seeJAVA UDF development.

Normally, the development of JAVA UDF can be done in the following ways:

Use MaxCompute Studio to complete the whole process of JAVA UDF development.
Use Develop and debug JAVA UDF using the Eclipse plug-in, export the Jar package, then

Add resources through commands or DataWorks, and Register the function.



For detailed development steps, seeJAVA UDF Development.

Debug the UDF program

After the UDF program is developed, it can be tested using unit test (UT) or local running to check

whether it meets expectations.

Unit Testing

There are various UT examples in the examples directory and you can refer to them to compile

your UT.

com.aliyun.odps.examples.udf.test
> (€ UDAFTest

~ (€' UDFTest

@Test

22 m jpublie void simpleInput () throws Exceptid

23 BaseRunner runner = new UDFRunmer { odps: |

24 rummer. feed(new Object[] { “ome”, v
.feed mew Object[] { “four”,

List{bject[]> out = rummer. yield():

i initWarehouse(J:void
il % inputFromTable(:void

il % resourceTest()wvoid

Tone’]

“Eomr]

il . simplelnput(:void

3 £ UDTFTest Assert assertEquals (3, out.size()):
> com.aliyun.odps.examples.unstructured Assert assertEquals ("ss2s:one, one”, Tes
> com.aliyun.odps.examples.unstructured.test hssert. assertiquals ("ssZsithree, three”
S data.ambulance csv Assert assertEquals("ss2s: four, four”, 1
> data.speech_wav B !
h 2 34 @Test
v [main — = > public void inputFronTable () throws Excey
v [Hjava = BaseRunner runner = new UDFRumner (TestUti
w € HelloDriver String project = "example_project”:
an main(StringD):void String table = “we_in2”;
v @M FirstUDF String[] partitions = new String[] { “p2i
m evaluate(String):Strin String[] colunns = new String[] { “cole”)
resources InputSowrce inputSource = L
» test 42 Object[] data;
Java 44 runner. feedidatal;
> target 45 }
= MyFristModule.iml List{bject[]> out = rumer. yisld();
pom.xml Assert assertEquals (3, out. size());
> scripts UDFTest ¢ simplelnput()

[ IDE and Plugin Updates: Intelli) IDEA is ready to update. (today 16:45)

Run locally

« MyfirstProject ; ('3 MyFristModule ; "% examples ; 5 com ; [0 aliyun » I9 odps + [0 examples » £0 udf § B0 test C"m y
[ Project ~ B = | #- 1+ | EMyFirstsQLosql € MyFirstUDF.java €' UDFTest.java
v N foirstPreie:t C:\Users\Administrator\ldeaProjects\M Project SDK is not defined
> idea :
i package com aliyun. odps. sxamples. udf. test:
v MyFristModule
v [ examples import ...

> com.aliyun.odps.examples 13
> com.aliyun.odps.examples.graph 14 B public class UDFTest {
> com.aliyun.odps.examples.mr
> com.aliyun.odps.examples.mr.test @BeforeClass
3 com.aliyun.odps.examples.udf public static void initWarchouse() { TestUtil. initWarehouse(); }
)

Copy

Copy as Plain Text
Copy Reference
Paste

Paste from History...
Paste Simple
Column Selection Mode
Find Usages
Refactor

Folding

Analyze

Search with Google

Go To

Generate...

OF Recompile 'UDFTestjava’

Run 'simplelnput()’
Debug 'simplelnput()’

Show in Explorer

Open in terminal

Local History

[§+ Compare with Clipboard

Ctrl+X
Ctrl+C

Ctrl+Alt+Shift+C
Ctrl+v
Ctrl+Shift+V
Ctrl+Alt+Shift+V
Alt+Shift+Insert

Alt+F7

>
Alt+Insert
Ctrl+Shift+F9
Ctrl+Shift+F10

while (idata = inputSource. getlextRow()) FZ Run ‘simpleInput()’ with Coverage

[ Create 'simplelnput{)’...

During local running of the UDF program, the running data source must be specified. The

following two methods are provided to set the test data source:

+ MaxCompute Studio uses the Tunnel Service to automatically download table data of a specific

project to the warehouse directory.



* The mock project and table data are provided. You can see example_project in warehouse to

set it by yourself.
Procedure

1. Right-click UDF Class and select Run UDF class.main(). The Run Configuration dialog box
is displayed. In normal cases, UDF/UDAF/UDTF data is used as columns in tables of a select
sub-statement. The MaxCompute project, table, and column need to be configured. (The
metadata is from the mock project under project explorer and warehouse.) Debugging for

complex types is also supported, as shown in the following figure:

Project Explorer - 1= | BJMyFirstsQLosgl € MyFirstUDF,java €' UDTFTestjava
+ - OEYS ¥ Z = |» Project SDK is not defined
v W hitpi//service.odps.aliyun.com/api import org junit.BeforeClass;
v 18] MySecondProject2 . -
. import org junit Test;
v [g Tables & Views
> [ bank data
3 emp_test_new 13 import java util List
> ] ods_user info_d 14 | otesotve ({“array<strust<s bigint y:bigint>> ~>bigiat“])|
> [ result_tabl 15 B public class UDIFTest UDTF{
> [ result_table 16
> [Etable1 17 Run/Debug Configurations ==
> Eltable2 18
> Eltable_3 = + — E ¥ > Name: UDTFTest [[]1Share []Single instance only
> [Eltable_a . > [Junit
> Eltables - Main class: com.aliyun.odps.examples.udf.test UDTFTest
v [ table 6 el ~ ‘AMaxCompute Java
= N " UDTFTest VM options:
> i MaxCompute SQL
col3 :BIGINT Program arguments:
> GFDefault -
B col4 BIGINT 5 ¥ Defaults
« Eltable 7 - Working directory: v
£ col1 sBIGINT i Environment variables:
B col2 :ARRAY<BIGINT=| _ = ’
> Eltables .
> Eweinl - Use classpath of madule: MyFristModule ~
> Ewinc -
3 [JJ Functions 31 [1Include dependencies with "Provided” scope
> [ Resources IRE: Default (<no JRE> - module not specified) v
Shorten command line: user-local default: none - jzva e ~
s b - : 5 .
Enable capturing form snapshots (requires JRE 5
*MaxCompute project: http://service.odps.aliyun.com/api >  MySecondProject2 ~ +
*MaxCompute table: | we_inl v
*Table columns: coll iescl,c2!
Download Record limit: | 100

2, Click OK.



[ Project -

1 out

[ scripts

[ target
[warehouse

1 meta_dev
3 __tables__
1 hy_test
l5| __schema__

[}
A
#

- I+ ahy_test x studimestl.osql x C) PlusHello java » = ] UDFTast java X
package myudf;
import com.aliyun.odps.udf.UDF;
public class PlusHello extends UDF {
// TODO define parameters and return type, e.g: public §
public String evaluate{String s) {
return "hello world:" + s;

}
public String evaluate(Long a, String b) {

return "hello world2:" +a + " " + b;
}

| 4 studioTest.iml

Run

>
=
=
+*

% 08

IS 4

fili External Libraries

PlusHello

o

LEIZZi¢+ 4 »

Test framework quit unexpectedly

@ Note:

console.

Local warehouse directory

/Library/Java/JavaVirtualMachines/jdkl.8.0_65.jdk/Contents/Home/bin/java ...

Testing started at 15:02 ...

[INFO]Start to write table scheme : meta_dev.hy_test——=/Users/liuyi/IdeaProjects,
[INFD]generate schema file: /Users/liuyi/IdeaProjects/studioTest/warehouse/meta,
[INFO]Finished to write table scheme : meta_dev.hy_test—->/Users/liuyi/IdeaProj¢
[INFO]Start to download table: 'meta_dev.hy_test', download mode:AUTO
[INFO]Tunnel DownloadSession ID is : 2016@932150300d492b70a01854c05

[INFO]Start to write table: meta_dev.hy_test—s=/Users/liuyi/IdeaProjects/studio”
[INFO]Finished write table: meta_dev.hy_test——=>/Users/liuyi/IdeaProjects/studio”
hello world2:1 a

hello world2:2 b

hello world2:3 c,d

Process finished with exit code @

If the table data under the specified project is not downloaded into glashourse, You need
to download the data first, default download 100 entries. If more data is required, use the
Tunnel Command of the console or table downloading function of Studio.

If the mock project is used or the table data is downloaded, directly run the program.
The UDF local run framework uses data in specific columns in warehouse as the UDF

input and run the UDF program locally. You can view log output and result display on the

The local warehouse directory is used to store tables (including meta and data) or resources for

local UDF or MR running. The following figure shows the warehouse directory.



5 Project v @ = | 8- 1| E _schema__

sandbox ~/ldeaProjects/sandbox project=example_project
.idea table=wc_inl

jDev columns=co11:STRING, col2:STRING, col13:STRING, col4:STRING

out
scripts
target
warehouse
example_project
__resources__
__tables__
rs_out
wc_inl
= schema__

pl=2
= schema__
wcC_out

Note:

The project name, tables, table name, table scheme, and sample data are under the

warehouse directory in sequence.

The schema file is configured with the project name, table name, and column name and type (
separated using a colon) in sequence. For a partition table, the partition column also needs to

be configured. (For a non-partition table, refer to wc_in1. For a partition table, refer to wc_in2).

The data file uses the standard CSV format to store table sample data.

= Special characters include comma, double quotation marks, and line feed (\n or \r\n).

= The column separator is comma and the line separator is \n or \r\n.

— |f the column content includes special characters, double quotation marks (“) must be
added before and after the column content. For example, if the column content is 3,No, it is

changed to “3, No”.

— |f the column content includes double quotation marks, each double quotation mark is
converted to two double quotation marks. For example, if the column content is a’b”c, it is
changed to “a”’b”’c”.

= \N indicates that a column is null. If the column content (string type) is \N, it must be
converted to “”\N™.

— The file character code is UTF-8.



2.6.3 Develop MapReduce

After the Create MaxCompute Java Module is created, MR can be developed.

Develop the MR program

1.

Right-click the module source code directory src > main, select New > java, and select

MaxCompute Java.

Create Driver, Mapper, and Reducer.

-

Create new MaxCompute java class |E|
Mame: Tl
Kind: & Driver -

oK Cancel

3. Set the input/output table and Mapper/Reducer class. The framework code is automatically

¢’ HelloDriver java

filled in the template.

HelloDriver

package mymr.myudf;

import ...

public class HelloDriver {

public static void main(String[] args) throws OdpsException {

JobConf job = new JobConf();

// TODO: specify map output types
job.setMapOutputKeySchema(SchemaUtils. fromString(_?));
job.setMapOutputValueSchema(SchemaUtils. fromString(_?));

// TODO: specify input and output tables
InputUtils.addTable(TableInfo.builder().tableName(_7?).build(), job);
OutputUtils.addTable(TableInfo.builder().tableName(_?).build(), job);

// TODO: specify a mapper
job.setMapperClass(_?);
// TODO: specify a reducer
job.setReducerClass(_?);

RunningJob rj = JobClient.runJob(job);
rj.waitForCompletion();



For details of developing MR, see To write MapReduce.

Debug the MR program

After the MR program is developed, test your code and check whether it meets the expectations.

The following two methods are supported:

Unit test (UT): There are WordCount UT examples in the examples directory. You can refer to

them to compile your UT.

| B7 Project = & = | #- |~ | @ HelloDnver.java € WordCountjava € WordCountTestjava
v W MyfirstProject Co\Users\Administrator\ideaProjects\M project SOK is not defined
’ ddea package al dp 1 test
. com. aliyun. odps. exanples. mr. test;
v [ MyFristModule
v [ examples impert »
w com.aliyun.odps.examples
> (B Testlhil b
Est . X Cerl +X
> com.aliyun.odps.examples.graph SES AL EN sches ¥ Copy Ctri+C
» com.aliyun.odps.examples.mr private final statie String INPUT = R
SRR T e . final S uTEv Copy as Plain Text
w ¢Om-35lruﬂ-0dp$-k‘xamp|es.mr.test private final statie String O )
‘e'wmdc T et .:i‘,‘"' TebCenf Jab Copg Refcrcr!c: Ctr|-:.ﬂ|'.+5hﬂl—(
* m;mﬂ‘-'.;“,'ﬁ.f.‘} T L & Paste Ctrl+V
> com.aliyun.odps.examples.u - -
" s !-hr.u dE = ’PI - Af public WordlountTest() throws Except  Paste from History.. Ctrl +Shift+V/
o !‘-’""”'D psxamplesudiiest 2 Testltil, 1n tWarehouse () Paste Simple Cirl+Alt+Shift+V
> com.n!:yun.odps.mmplcs.unstrudured e S Column Selection Mode Alt+Shift+Insert
» com.aliyun.odps.examples.unstructured tesT| job = new JebComE () = e
> data.ambulance_cov —_ IHF Usages
> data.speech_wav job_ zetMapperClass (WordCoumt Teleent Befactor >
3 SIC Job. setConbinerClass WordCount Sunt Folding >
> target — Job setReducerClass WordCeunt SunRs Analyze >
 MyFristMeduleiml Search with Google
- I Job. setMaplutpatEeySchena (S chemallta]
1M pom.xm Ga To ?
. job. setMagutput¥alues chema (Schemall
. SCripts Generate... Alt+Insernt
» .IdE-:i InputUtils sddlable (TableInfe. buildd Recompile "WordCountTest java' Ctrl+Shift+F2
EJMyfirstsQLosql OutpurVeils. addfable TsbleInfo. buil JETIRI ey Ctrl+Shift+F10
targ e: 4 ik Debug "WerdCountTest’
A warenouse F# Run 'WordCountTest' with Coyerage
v example_project @Suppressiarnings ("deprecation”) _
— 5| Save "WordCountTest'
> _resources__ 8 X
- tables » public veid testMap() throws I0Exce  Showin Explorer
- ads_Jog NaplTCantext mapCentext = new MaplTi B Open in terminal
- sehema napContext. setInpatsSchema (TRPUT_SC) Local History 5
d_: _ H
mapContext, setlutputSchema (OUTPUT_2 .. B .
d data Fﬂ_._ B8 ¥ =1+ Compare with Clipboard
> [ kmeans_in Neoard record = maplantext. oreatelng  FIE Encoding
> kmeans_cut record set{new Text[] fnew Text( =l & Create Gist...

Local MR running: During local running, the running data source must be specified. The following

two methods are provided to set the test data source:

+ MaxCompute Studio uses the Tunnel Service to automatically download table data of a
specific MaxCompute project to the warehouse directory. By default, 100 data records are
downloaded. If more data is required for testing, use the Tunnel Command of the console or
table downloading function of MaxCompute Studio.

* Provide the mock project (example_project) and table data. You can see example_project in

warehouse to set it by yourself.



1. Run the MR program. Right-click the Driver class and select Run. In the displayed Run

Configuration dialog box, configure the MaxCompute project on which the MR program runs.

.

x

> P Defaults

2]

Run/Debug Configurations

WordCountTest
> ‘AMaxCompute Java
> ‘“AMaxCompute SQL

VM options:
Program arguments:
Working directory:

Environment variables:

Use classpath of madule:

JRE:

Shorten command line:

=]

[ Share []Single instance only

+ — B EH % 1+ »  Name: WordCountTest

e ElJliT';T:Teg-_ Configuration | Code Coverage | Logs
XUDFTest.simplelnput Test kind: Class ~| Fork mode: | none ~ | Repeat: | Once
XUDTFTest.simplelnput Class: com.aliyun.odps.examples.mrtest WordCountTest

—ea

%MODULE_WORKING_DIR%

MyFristModule

Default (=

JRE= - madule not specified)

user-local default: none

+ Before launch: Build, Activate tool window

+
 Build

[] Show this page

Activate tool window

@ Warning: No JDK specified for module ‘MyFristModule'

Apply

Click OK. If table data of the specified MaxCompute project is not downloaded to warehouse,

download data first. If a mock project is used or the MaxCompute project table data is

downloaded, skip this step. Then, the MR local run framework reads specified table data in

warehouse as the MR input and runs the MR program locally. You can view log output and

result display on the console.

Run /. WordCount

» /Library/Java/JavaVirtualMachines/jdk1.8.0_65. jdk/Contents/Home/bin/java ...
[INFO]Run mapreduce job in local mode, Type: MR, Job ID: mr_20170221193325_750_3935

[INFO]Start to
. [INFO]Start to
= [INFO]Finished
[INFO]Start to
[INFO]Finished
[INFO]Finished
[INFO]Start to
[INFO]Start to
[INFO]generate
[INFO]Finished
[INFO]Finished
[INFO]Start to
[INFO]Finished
[INFO]Start to
[INFO]Finished
[INFO]Start to
[INFO]Finished
[INFO]Start to
[INFO]Start to
[INFO]Start to

% 3
e o @

~ X

process input tables

copy table: example_project.wc_inl-—>/Users/liuyi/IdeaProjects/sandbox/temp/mr_20170221193325_750_3935/input/example_project/wc_inl
copy table: example_project.wc_inl-->/Users/liuyi/IdeaProjects/sandbox/temp/mr_20170221193325_750_3935/input/example_project/wc_inl

copy table: example_project.wc_in2{pl=2, p2=1}-->/Users/liuyi/IdeaProjects/sandbox/temp/mr_20170221193325_750_3935/input/example_project/wc_in2
copy table: example_project.wc_in2{pl=2, p2=1}-->/Users/liuyi/IdeaProjects/sandbox/temp/mr_20170221193325_750_3935/input/example_project/wc_in2

process input tables
process output tables

write table scheme : example_project.wc_out-—>/Users/liuyi/IdeaProjects/sandbox/temp/mr_20170221193325_750_3935/output/__default__

schema file: /Users/liuyi/IdeaProjects/sandbox/temp/mr_20170221193325_750_3935/output/__default__/__schema__
to write table scheme : example_project.wc_out-—>/Users/liuyi/IdeaProjects/sandbox/temp/mr_20170221193325_750_3935/output/__default__

process output tables
process resources
process resources
fill tableInfo

fill tableInfo
validate configuration
validate configuration
run mappers, num: 2

run mapper, TaskId: M_000001, Input: example_project.wc_inl

run Combiner, TaskId: M_000001

[INFOIFininshed run Combiner, TaskId: M_000001
[INFO]Fininshed run mapper, TaskId: M_000001, Input: example_project.wc_inl




Run the MR program in the production environment

After local debugging is complete, release the MR program to the server and run it in the

MaxCompute distributed environment.

1. Package the MR program to a JAR package and release it to the server. For more information

, See How to package and release MR.

2. Use the MaxCompute console integrated with MaxCompute Studio in seamless mode, that is,
in the Project Explorer window, right-click Project and select Open in Console, and input the

commands similar to the following JAR command in the console command line:

jar -libjars wordcount.jar -classpath D:\odps\clt\wordcount.jar com
al i yun. odps. exanpl es. nr. WordCount wc_in wc_out;
2.6.4 Unstructured development
An unstructured data processing framework is added for MaxCompute 2.0, supporting access

to the OSS and Table Store using external tables. Studio provides some code templates for the

framework, facilitating users' fast development.
Compile StorageHandler/Extractor/Outputter
1. After the MaxCompute Java Module (Sample code is provided in the unstructured folder of the

examples directory for your reference).

2. Right-click the module source code directory src > > main, select new, and select

MaxCompute Java.

3. Specify Name and Kind. For example, set Name to myun.MyExtractor and Kind to Extractor.

Click OK.

Create new MaxCompute java class EZ
Mame:  myun.Extractor !
Kind: Extractor ~

OK Cancel

4. The framework code has been automatically filled in the template. Compile your logic code.

5. Compile Outputter and StorageHandler by following the preceding steps.


https://www.alibabacloud.com/help/doc-detail/50904.htm
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Unit Testing

You can compile the unit test (UT) by following the examples in the examples directory to test your

Extractor/Outpultter.
Project - @ = | #- |- (& ExtractorTestjava
w.'\stu(fioTest ~/ldeaProjects/studioTest ExtractorTest || ambulanceFullSchema
-idea 3 import ...
jdev 18
examples 19 G plodlic class ExtractorTest {
com.aliyun.odps.examples 20 private StrilMETTEITTEFullSchena =
21 “vehicle:bigint;id:bigint;patient:bigint;calls:bigint;latitude:dc
m(;f 22 private String speechDataFullSchema = "sentence_snr:double;id:string'
u 23
unstructured 24 @Test
test 25 G public void testTextExtractor() throws Exception {
26 /%%
ExtractorTest 27 x Equivalent to the following SQL:
¢’ » OutputerTest 28 CREATE EXTERNAL TABLE ambulance_data_external
¢ SpeechSentenceSnrExtractor.jave 2° ( vehicle bigint, id bigint, patient bigint, calls bigint,
30 Latitude double, Longitude double, time string, direction string)
< ShecchStorageliendiey 31 STORED BY 'com.aliyun.odps.udf.example.text.TextStorageHandler'
¢ = TextExtractor 32 LOCATION ‘oss://.../data/ambulance_csv/'
E TextOutputer 33 USING 'jar_file_name.jar';
¢ % TextStorageHandler 34
= TestUtil 35 SELECT * FROM ambulance_data_external;
36 */
data 37 Column[] externalTableSchema = UnstructuredUtils.parseSchemaString!

Package and upload

After StorageHandler/Extractor/Outputter is compiled, compress the completed Java program to a

JAR package, and upload the package as a resource to the server, see Package and release.
Create External Table

1. Right-click scripts and select new > MaxCompute Script.



L MyFrist Cut Cirl+x | K Klotlln File/Class
5 pom.xr |5 Copy Crl+c | = File
=] " scripts Copy Path Cirl+Shifi+c | 5o Scratch File Ctrl+Alt+Shift+Insert
o pd
=
= » adea Copy Reference Cirl+Alt+Shift+C Package
3] .
1:& EJMyFirst| (2 Paste Ctrl+y | im FXML File
target Find Usages Ale+F7 |" pac:algel-l:fcfdava
> Mmwarehouss  Find in Path... Ctrl+Shift+F |2 TOSH eIV
u MyfirstPro, Replace in Path... Cirl+Shift+R MaxCompute SQL EI&
> |l External Libral  Analyze 3 ] MaxCompute SEETEE
M D2 hE
¥ [ Scratches and Refactor 5 E :
a HTML File
miimlpaiies ¢ i JavaFXApplication
Show Image Thumbnails Ctrl+Shift+T <
i Singleton
Reformat Code Cirl+Alt+L |8 Gradle Kotlin DSL Build Script
Optimize Imports Cirl+Alt+0 | & Gradle Kotlin DSL Settings
Delete... Delete | 20 XSLT Stylesheet
Build Module "MyfirstProject’ Edit File Templates...
(1) = 0 T '
% Rebuild '=default= Ctrl+Shift+F2 GUI Eorm
é Show in Explorer Dialog
I [E Open in terminal Form Snapshot
= B Set MaxCompute project .1 Resource Bundle
n Local History > Plugin DevKit >

2. Enter the SQL script name. Select the MaxCompute project in which the script is to be
executed for Target Project and click OK.
3. Select create external table live template in the editor to rapidly insert the script template for

creating an external table.

Modify the external table name, column, type, StorageHanlder class path, configuration
parameter, external path, and JAR name. Click Run MaxCompute SQL Script to create the
external table.

4. Query the created external table.

2.6.5 Package. Upload and Register

After a user-defined function or MapReduce is developed, you must package and release it to the

MaxCompute system.
Package a UDF or MapReduce

To release a UDF or MapReduce to the MaxCompute server for production use, you must
complete packaging > uploading > registration in sequence. You can use the one-click
release function to complete these procedures. MaxCompute Studio runs the mvn clean package

command, uploads a JAR package, and registers the UDF in one stop. To use this function, right-



click the UDF or MapReduce and select Deploy to server.... Make sure that the target class is

in the src > main > java subdirectory and is successfully compiled on the Maven module. The
dialog box shown in the following figure appears. Select the MaxCompute project to be deployed
and enter a resource name and a function name. Click OK and wait until the operation in the

background is complete.

Package a jar and submit resource | £3 |

*MaxCompute project: MySecondProject? (service.odps.aliyun.com) +
*Resource name: MyFristModule-1.0-5SNAPSHOT jar

*Main class:| MyFirstLIDF
*Function name:

Force update if already exists

ﬂ oK Cancel

E] Note:

If you require special packaging, you can modify relevant settings in the pom.xml file. After

packaging, follow these steps to upload the JAR package and register the UDF.
Upload the JAR package
After the JAR package is prepared, upload it to the MaxCompute server.

1. Select Add Resource from the MaxCompute menu.
2. Select the MaxCompute project you want to upload the resource to, the JAR file path, and the
resource name you want to register. Determine whether to force update when the resource or

function already exists. Then click OK.

Add Resource [ E3 |

*MaxCompute project: MySesmen®rmpeai? (service.odps.aliyun.com) +
*Resource file: /MyfirstProject/MyFristModule/sre/mainfjava/MyFirstUDF java

*Resource name: MyFirstUDF java

Force update if already exists

Iﬂ OK Cancel




3. After uploading is successful, you can view the resource under the Resources node of the

Project Explorer window.

| Project Explorer - I-
o —

s+ — O S ¥ = =
VY http://service.odps.aliyun.com/api
= v TP] MySecondProject2

- > [J Tables & Views

@ v

I+ 2 @ Functions

= v Resources

s » mylower.jar

o
?m
(518

Wi

Register the UDF
After the JAR package is uploaded, register the UDF.
1. Select Create Function from the MaxCompute menu.
2. Select the required resource JAR and JAR main class, and enter the function name. Click OK.

Create Function

*MaxCompute project: MySecondProject? (service.odps.aliyun.com)

*Function name:

MyMaodule-1.0-SNAPSHOT jar

*Using resources:

*Main class: MyFirstUDF ~
Force update if already exists

function name can't be empty

(7] Cancel

3. After the registration is successful, you can view the function under the Functions node of the

Project Explorer window.

v meta_dev

FE Tables & Views
(] Functions

- fx plushello

- frss2s
71 Resources



Apply the UDF

» Apply the UDF in SQL to complete subsequent development.

Em.osql x
o W p meta_dev

P Surround with ()
PARSE_URL(STRING,STRING)

PERCENT_RANK()

PI()

PMOD(DECIMAL ,DECIMAL)

POSITIVE(T)

POW(DOUBLE , DOUBLE)

POWER(DECIMAL,DECIMAL)

PRINTF(STRING, ANY)

MAY OT/CTDTMY
Press <. to choose the selected (or first) suggestion and insert a dot afterwards 2> i

2.6.6 Develop Graph

After the MaxCompute Java module is created, Graph can be developed.
Sample Code

There are some code examples of Graph in the examples directory, and you can refer to the

example to get familiar with the structure of the Graph program.

Project v @ =  #- |- (@ PageRankjava
W\ sandbox ~/ldeaProjects/sandbox
.idea import ...
graph ok
examples * Set program arguments:
com.aliyun.odps.examples % pagerank_in pagerank_out
graph *
»> */
c’ T public class PageRank {
¢ PageRank
¢’ SSSP public static class PageRankVertex extends
mr Vertex<Text, DoubleWritable, NullWritable, DoubleWritable> {
udf @0verride
unstructured ) public void compute(ComputeContext<Text, DoubleWritable, Nullwr
¢ TestUtil Iterable<DoubleWritable> messages) throws IOException {
data if (context.getSuperstep() == @) {

setValue(new DoubleWritable( value: 1.8 / context.getTotalNun

sre } else if (context.getSuperstep() >= 1) {
target double sum = 0;

= graph.iml for (DoubleWritable msg : messages) {
pom.xml sum += msg.get();

Develop a Graph Program

1. Right-click the module source code directory src > > main, select new, and select

MaxCompute Java.
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2. Select the GraphLoader/Vertex type and enter the class name (package name is supported) in

the Name text box. Click OK, and the frame code will be automatically filled in by the template,

you can continue to modify.

Create new MaxCompute java class @

Mame: Tl

Kind: | ure UDE v|

5 StorageHandler
|\ Extractor

g () Outputer —
U upd
Y\ Vertex

W\ VertexResolver

| '
%\ Combiner —

Debug Graph Locally

After the Graph program is developed, test your code and check whether it meets the expectatio

ns. You can run the Graph code locally.

. Run the Graph program: Right-click the Driver class and select Run. In the displayed Run

Configuration dialog box, configure the MaxCompute project on which the Graph program

¥ "
& Ampert B Run/Debug Configurations =
i
L » public elass HelleDriver { + - mH ¥t MName:  PageRank [Jshare [] Single instance only
2 g public static veid sain(Stringl] args) throws Odp ’ - Junit Main class: comaliyur.odps.examples.graph.PageRank
1 ~ ViMaxCompute Java
Y Wi UDTFTest Sons:
] TabConf job = mew TobConf (): ¥htlophans
et NerdCount
& Program apguments: PageRank_in PageBank_cat
TOD0: specify map emtput types

Job. setMaplutputKeySchena Schemalitils fremString(] Working directory: |
2 jab. setMaplutputValusSchena (Schemalltils. froaStrin B S

méiranment variables:

=
=
% TODO: specify input and suiput tables
= IngutUtils. addfable TableIngo. builder (). takLeliame] Use classpath of module: | I MyFristModule =
- Outpnilitils. addfable TableInfo. builder (). tablalian) D Include deper\drn(irs with “Provided® scope

T0D0: specify s mapper JRE: Drefault (1. . Viodule' m
jab. setMupparClass (7} Shorten command fre: | user-local default: none =
TODO: specify a reduesr

job. setReduserClus 7} [ Enable capturing form snapshots

BusmingTeb ¥j = Jeblliont, runfeb(jeb); “MaxCompute project: local ~ | example_project L

r3 waatFerConpletion():
2 ek : Download Record limit: | 100

HelloDriver * main{)

Messages:  Build = Before launch: Build, Activate tool window
W T @ Informaticn: java: Errors occurred while compiling m: +
s . O Information: javac 180181 was used to compile jave Yead
g T @ Information: 2018/12/13 16:15 - Compilation complet] =
3 X @~ 2w imini i tyfi j ] Show this page [] Activate tool window
=) i O Errori(17, 59) java: AT TS
- © Erron(17,60) jave: WEMBETTTE
+ ¥

@ Errori(17, 61) java: IEERES T
B Errori(17,62) java: REY

O Erroni17. 63) java: BE)
Cancel I
© Error(18,61) jova: SEESMEST L ance apply

F 2 Favorites
]

. Click OK. If table data of the specified MaxCompute project is not downloaded to warehouse,

download data first. If a mock project is used or the MaxCompute project table data is



downloaded, skip this step. Then, the graph local run framework reads specified table data
in warehouse as the Graph input and runs the Graph program locally. You can view log output
and result display on the console. Each time you debug locally , a new temporary directory is

created under the Intellij directory, as shown in the following figure:

[ Project - @ =  #- I~ (@ PageRankjava
» 5 , e R e e
V.8 sanfidbox IdeaProjects/sandbox vertex.addEdge(new Text(edge.toString()), NullWritable.get());
.idea
graph }
out System.out.println(“vertex edgs size: " + (vertex.hasEdges() ? vertex.getEdges().size() : 0));
) context.addVertexRequest(vertex);
scripts }
target
temp ¥
A\ raph_201 22144 4_147!
I graph_201803 03‘3 o AAF private static void printUsage() {
counters 4— fRUIE{TH— LT AIER System.out.println("Usage: <in> <out> [Max iterations (default 30)]");

System.exit( status: -1);

output<€¢—— Rl
resource €—— {El{EFAL

@ 'pub'lic static void main(String[] args) throws IOException {
superSteps €—— E— LA 1 if (args.length < 2)
@i job.xml €— (R printUsage();
warehouse .
= sandbox.iml Graphlob job = (TTEFTINEAN;
\lli External Libraries job.setGraphLoaderClass (PageRankVertexReader. class) ;

ioh.setVertexClass(PaaeRankVertex.class) :
PageRank main()

Run '/ PageRank
f&5: Start to write table scheme : example_project.pagerank_out——>/Users/liuyi/IdeaProjects/sandbox/temp/graph_20180322144903_634_1476/output/__detault__

| i =H 22, 2018 2:49:03 T4 com.aliyun.odps.local.common.utils.SchemaUtils generateSchemaFile
3 generate schema file: /Users/liuyi/IdeaProjects/sandbox/temp/graph_20180322144903_634_1476/output/__default__/__schema__
_ =B 22, 2018 2:49:03 T4 com.aliyun.odps.local.common.utils.SchemaUtils generateSchemaFile
=3 Finished to write table scheme : example_project.pagerank_out-->/Users/liuyi/IdeaProjects/sandbox/temp/graph_20180322144903_634_1476/output/__default__
5] 2, 2018 2:49:03 T4 com.aliyun.odps.graph.local.master.Master init
E8: worker num :1
o | @
= vertex edgs size: 2
&
- 1
X 3

vertex edgs size: 2
4

2
3

E] Note:

For a detailed introduction to warehouse, see Local Warehouse Directory section in Develop

UDF.
Run the Graph Program in the Production Environment

After local debugging is complete, release the Graph program to the server and run it in the

MaxCompute distributed environment.

1. Package the Graph program to a JAR package and release it to the server. For more
information, see How to package and release Graph.

2. Use the MaxCompute console integrated with MaxCompute Studio in seamless mode, that is,
in the Project Explorer Window, right-click Project and select Open in Console, and input the

commands similar to the following JAR command in the console command line:

jar -libjars xxx.jar -classpath /Users/hone/xxx.jar com aliyun. odps.
gr aph. exanpl es. PageRank pagerank_i n pagerank_out ;

2.7 Configure options
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2.7.1 Configure MaxCompute Studio
After the MaxCompute Studio plug-in is installed, you can find configuration items of MaxCompute
Studio on the left bar of the Settings page of Intellid IDEA. For more information about how to

open the IntellidJ IDEA configuration page, see IntelliJ IDEA Documentation.

MaxCompute Studio configuration option page
The MaxCompute Studio configuration option page provides the following configuration items:
1. Path for storing the local metadata base

Specifies the path for locally storing metadata of a MaxCompute project. On MaxCompute
Studio, the metadata is stored in the hidden directory . odps. st udi o/ et a of the local user

directory by default.

2. Version update options

* You can use the Automatically checks for new version check box to control whether

MaxCompute Studio automatically checks for new version updates.

* You can use the Check new versions button to manually check new versions. After you
click this button, if a new version is available, the Install new version button is displayed.
You can click this button to install the new version, and restart IntelliJ IDEA after the

installation is complete.
SDK and Console configuration option page
The SDK and Console configuration option page provides the following configuration items:
1. Path for installing a MaxCompute client

Specifies the path for local installation of MaxCompute client. MaxCompute Studio detects the
version of the MaxCompute client installed in the path. If detection fails, an error message is

prompted.

Note:
MaxCompute Studio later than the 2.6.1 version provides the latest MaxCompute client. You
do not need to specify the path. If you must use a MaxCompute client of a specific version,

you can specify the path.
MaxCompute SQL configuration option page
The MaxCompute SQL configuration option page provides the following configuration items:

1. Enable syntax coloring


https://www.jetbrains.com/help/idea/2016.3/accessing-settings.html

Select Enable syntax coloring to enable the syntax highlighting feature.

2. Enable code completion

Select Enable code completion to enable the automatic code complementing feature.

3. Enable code formatting

Select Enable code formatting to enable the code formatting feature.

4. Compiler options

These are global default compiler options. The following options can be separately set for each

file on the toolbar of the SQL compiler.
* Compiler Mode

- Statement Mode: In this mode, the compiler compiles and submits a single statement of
an SQL file as a unit.

= Script Mode: In this mode, the compiler compiles and submits an entire SQL file as a
unit. NOTE: Script Mode enables the compiler and optimizer to optimize the execution

plan and improve the overall execution efficiency. This mode is in the test phase now.

* Type System

— Legacy TypeSystem: Indicates the type system of original MaxCompute.

— MaxCompute TypeSystem: Indicates the new type system introduced by MaxCompute 2
.0.

— Hive Compatible TypeSystem: Indicates the type system in Hive compatibility mode

introduced by MaxCompute 2.0.

» Compiler Version

= Default Version: Indicates the default version of the compiler.
= Flighting Version: Indicates the experimental version of the compiler, which includes new

features of the compiler being tested.
Account configuration option page

You can add or manage accounts used to access MaxCompute on the Account configuration

option page. For more information, see User authentication.

You must specify an account on MaxCompute Studio to access a MaxCompute project and run or

submit jobs. MaxCompute Studio currently supports the following account type:

+ Alibaba Cloud account (AccessKey)



Add an account
On the Account configuration option page, follow these steps:

1. Click +orpress Ctrl - N.
2. Select the account type Aliyun Account by AccessKey.

3. In the displayed Add Account window, set the following items:

+ Account Nane: Indicates the name of the account on MaxCompute Studio.

« Using properties fil e:Readthe AccessKey ID and AccessKey Secret from the

configuration file.

= Select the configuration file conf/ odps_confi g. i ni after you process User

authentication.

+ Using properti es: Manually enter the AccessKey ID and AccessKey Secret.

— Access | d: Enter the AccessKey ID of your Alibaba Cloud account.

— Access Key: Enter the AccessKey Secret of your Alibaba Cloud account.

- %

Add MaxCompute project | 22 |

Odps.ini files need to be
downloaded in advance to initialize

Connection  Setling ¢ ration items such as AK/Endpoi

Properties File: load\MaxCompute Client\conf\odps_config.ini

AK Account: sing AK account to initialize AK, yau can
click on the right + to ad«d.

* Access Id: LT A g i 17 1hD

* Access Key: oAPref Tl et Sl Aa®0 2R r2) JEF
* Project Mame: | MySecondProject2

* End Point: http://service.odps.aliyun.com/api

) Cancel

4. Click OK to complete addition. Then, the account will be displayed in the Account list on the

Account configuration option page.
Delete an account

On the Account configuration option page, follow these steps: (This operation only deletes the

account configuration on Studio configuration, which does not affect your account.)



1. Select the account to be deleted in the account list.
2. Click -.

3. In the displayed dialog box, click OK.
Modify the AccessKey of an account
On the Account configuration option page, follow these steps:

1. Select the account to be deleted in the Account list.
2. Click the pencil icon.
3. In the displayed Edit Account window, modify the account information. The content is similar

to that in the preceding section Add Account.

View the opening and connection of MaxCompute Region and the settings of Endpoint, see

Endpoints and Data Centers.



3 Downloads

This document provides you with the download address of the relevant tools and plugins.

+ SDK Downloads: Maven users can search odps-sdk from Maven library to get different

versions of the Java SDK.
*  MaxCompute console
» Eclipse plugin
» Intelij plugin, Studio


http://repo.aliyun.com/download/odpscmd/latest/odpscmd_public.zip
https://docs-aliyun.cn-hangzhou.oss.aliyun-inc.com/cn/odps/0.0.90/assets/download/odps-eclipse-plugin-bundle-0.16.0.zip
https://www.jetbrains.com/idea/?spm=5176.doc50891.2.4.2O5djt
https://plugins.jetbrains.com/plugin/9193-maxcompute-studio
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